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PanelView Plus 7 Standard Terminals User Manual

Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING: |dentifies information about practices or circumstances that can cause an explosion in a hazardous environment,
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

> P

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

Labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may
reach dangerous temperatures.

ARC FLASH HAZARD: Labels ma¥ be on or inside the equipment, for example, a motor control center, to alert Beople to
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

B> > P>

N
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Preface

This manual describes how to install, configure, operate, and troubleshoot the
PanelView™ Plus 7 Standard terminals. It does not provide procedures on how
to create applications that run on the terminals or ladder logic that runs in the
controller.

Other tasks to perform include:

e Create a human machine interface (HMI) application for the terminal
by using FactoryTalk® View Machine Edition (ME) software, version 7.0
or later.

e Create ladder logic for the controller by using the Studio 5000 Logix
Designer® application.

Summa ry of Changes This manual contains new and updated information as indicated in the
following table.
Topic Pages
Updated the ERR codes. 140
Package Contents This product is shipped with the following items:

e PanelView Plus 7 Standard terminal with FactoryTalk View ME Station
runtime software installed and activated

e Mounting levers for panel installation
¢ Removable power terminal block

e Secure Digital (SD) card cover

¢ Product information

¢ Cutout template

o China RoHS information

e Product Feature Notice

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021 7



Preface

Product Release Notes Product release notes are available online within the Product Compatibility

and Download Center.

1. From the Quick Links list on http://www.ab.com, choose Product
Compatibility and Download Center.

Quick Links L]

¥ Praduct Dm’_ﬂ::nry Rockwell »RnckweuAummamnWnrmwne
Automation UsEN. THINK SOVE Search
* Product Catalogs

Products & Technologies Solutions & Services News & Innovation Training & Events Sales & Partners Support About Us

- =
Product Certifications 3 Home » Support » Product Resources  » Product Compatibilty & Download Center

e Product Compatibility
o and Download Center

* Product Compatibility and
Download Center

' Product News

Suppert [+] Get help determining how different praducts interact. Compare features and capabilities between different series of products and
PT l & H I associated firmware versions. The Product Compatibility and Downloads Center can help you find product related downloads including
oms BEOUNCES Product Resources firmware, release notes, associated software, drivers, tools and utilities.
* Literature Librany » Literature Library
Product Compatibility & i ibili oS ~ Get 3 Find Answers »

Download Center
¥ Product Catalogs

» Product Certifications Multi-Product Compare
} Silver Series I need to upgrade one or more products and | want to check compatibility between the new product(s) and the other
*» Product Data Sheets product(s) in my system.

* Learn More

2. From the Compatibility Scenarios tab or the Get Downloads tab, search
for and choose your product.

Start by selecting products

Product Search:
| search by name or description |AII Categories j |AII Families j GO |

Exampl=: 1756-LET, LES, Logix, Ethemef Yow can also filfer by product categonys or famil)y.

3. Click the download icon é“i_l to access product release notes.
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Preface

Additional Resources

These documents contain additional information concerning related products
from Rockwell Automation.

Resource

Description

PanelView Plus 7 Standard Terminals Technical Data,
publication 2711P-TD008

Provides technical specifications, environmental specifications, and certifications for the PanelView Plus 7 Standard
terminals.

Industrial Automation Wiring and Grounding Guidelines,
publication_1770-4.1

Provides general guidelines for installing a Rockwell Automation industrial system.

EtherNet/IP Embedded Switch Technology Application
Guide, publication ENET-AP005

Provides information on how to install, configure, and maintain linear and Device Level Ring (DLR) networks using
Rockwell Automation® EtherNet/IP devices with embedded switch technology.

Safety Guidelines for the Application, Installation, and
Maintenance of Solid-State Controls, publication SGI-1.1

Provides general guidelines for the application, installation, and maintenance of solid-state control in the form of
individual devices or packaged assemblies that use solid-state components.

Guidelines for Handling Lithium Batteries Technical Data,
publication AG-5.4

Provides guidelines to store, handle, install, and dispose of lithium batteries.

Product Certifications website, rok.auto/certifications

Provides declarations of conformity, certificates, and other certification details.

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021
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https://www.rockwellautomation.com/global/detail.page?pagetitle=Product-Certifications&content_type=tech_data&docid=de1cc7d81606981b0f214fed1137f539
www.rockwellautomation.com/literature
http://literature.rockwellautomation.com/idc/groups/literature/documents/td/2711p-td008_-en-p.pdf
http://www.literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/ap/enet-ap005_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/td/ag-td054_-en-p.pdf

Preface

Notes:
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Chapter 1

About the PanelView Plus 7

Standard Terminals

Overview

Topic Page Topic Page
About the PanelView Plus 7 Standard Terminals | 11 Start-up Options 15
Hardware Features 12 EtherNet/IP Communication 15
Operator Control 13 Typical Configuration 15
Software Support 13 (atalog Number Explanation 16
Windows CE Operating System 14 Product Selections 16
Open Versus Closed System 14 Accessories 17
Desktop Access 15 Ethernet Cables 18

The PanelView™ Plus 7 Standard terminals are operator interface devices. They
monitor and control devices that are attached to ControlLogix® 5570 and
CompactLogix™ 5370 controllers on an EtherNet/IP™ network. Animated
graphic and text displays provide operators a view into the operating state of a
machine or process. Operators interact with the control system by using touch

screen input.

The PanelView Plus 7 Standard terminals include these features:

e Terminal functionality permits connection to 1 controller, up to 100

screens, and up to 500 alarms.

o FactoryTalk® View Machine Edition software provides a familiar

environment for creating HMI applications.

e Windows CE operating system with desktop access for configuration
and third-party applications.

e Ethernet communication that supports Device Level Ring (DLR),
linear, and star network topology.

e PDF viewer to access PDF files that are stored on the terminal.

e More screen options including 4-in., 6-in., 7-in., 9-in., 10-in., 12-in., and

15-in. terminals.

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021
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Chapter 1

Hardware Features

e Widescreen on three sizes, 4-in., 9-in., and 12-in. terminals.
o Greater screen resolution.
e Terminals are available with Allen-Bradley® branding, or with no

branding for customers that want to put their own branding around the
terminal.

e Certifications including Class I, Div. 2; Class II, Div. 2; Class III;
ATEX, IECEx, and INMETRO Zones 2 and 22.

The PanelView Plus 7 Standard terminal features fixed-hardware
configurations in a range of display sizes with touch screen input.

h pre—m M\
(]
(]
5 6 ‘ 2 1
] ¥ ‘\\
- Terminals with dual Ethernet A{ 3 2
ports.
L . . 1
v 00000000000 Throughout this user manual, illustrations show the
et e — — terminals with dual Ethernet ports.
- Terminals with one Ethernet port.
4
Table 1- Hardware Features
Item | Feature Description
1 Display/Touch screen TFT color graphic display with a touch screen in a range of sizes:
« 4.3-in. wide screen touch (WQVGA)
« 5.7-in. touch (VGA)
+ 6.5-in. touch (VGA)
«9.0-in. wide screen touch (WVGA)
+ 10.4-in. touch (SVGA)
« 12.1-in. wide screen with touch (WXGA)
«15.0-in. touch (XGA)
2 Power 24V DCnom (18...30V DC) nonisolated power input
3 Ethernet port « One 10/100Base-T, Auto MDI/MDI-X, Ethernet port for controller communication and IEEE 1588 support for synchronization of
(Tor2) network-connected devices .
« Two 10/100Base-T, Auto MDI/MDI-X, Ethernet ports for controller communication that supports Device Level Ring (DLR) network
topology.
4 Mounting slots Mounting levers insert into the slots to mount device in a panel or enclosure. The number of slots varies by terminal size.
5 Universal serial bus (USB) | One USB 2.0 high-speed (type A) host port.
host port
6 USB device port One USB 2.0 high-speed (type B) device port for connecting a host computer.
12 Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021
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Table 1- Hardware Features

Item

Feature

Description

7

SD card slot and
protective cover

« One SD card slot supports catalog number 1784-SDx hot-swappable SD cards for external storage.

« IMPORTANT: ATEX and INMETRO installations:
— Protective cover secures the SD card in the slot, and is required for ATEX, INMETRO, and hazardous location installations.
— See Insert an SD Card on page 123 for hot-swapping, ATEX, INMETRO, and hazardous location warnings.

Battery

Battery cover provides access to the lithium battery for replacement.

Status indicators

Status indicators on the back of the terminal provide status and fault conditions.

Operator Control

Software Support

All terminals have a color display with a touch screen for operator control. The
resistive touch screen provides accurate, reliable, and durable touch control for
industrial applications.

ATTENTION: The touch screen accepts input from a finger, stylus, or gloved
hand for operation in dry or wet environments.

The plastic stylus must have a minimum tip radius of 1.3 mm (0.051in.).
Any other object or tool can damage the touch screen.
Do not conduct multiple operations simultaneously; it can result in unintended

operation. Touch only one operating element on the touch screen with one
finger, at one time.

TIP  Atruntime, a virtual keyboard or numeric keypad opens on terminal
screens for data entry.

The touch screen supports touch gestures to interact with screen elements
during runtime. Use only these touch gestures on the touch screen:

o Tap — Briefly touch the target on the terminal screen with your
fingertip.

¢ Double-tap — Touch the target on the terminal screen twice quickly
with your fingertip.

e Drag - Touch the target on the terminal screen and move your fingertip

across thC screen.

o Long press — Touch and hold the target on the terminal screen for
several seconds.

For a list of actions you can perform by using touch gestures, refer to the

FactoryTalk View ME help.

IMPORTANT  Itis the responsibility of the customer to be sure that any third-party
software, updates, patches, or firmware that is installed is free of malicious
bugs, spyware, and so on.

Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021 13
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Table 2 - PanelView Plus 7 Standard Software Support

Software Description Version
FactoryTalk View ME Station Runtime environment of terminal: 7.0 or later
+ Runs FactoryTalk View ME applications.
« Provides options to view and configure terminal settings.
Machine Edition Station is preloaded on each terminal and does not require activation.
FactoryTalk View Studio for Machine Edition Software for developing the HMI applications that run on terminal. This software does not run on the 7.0 or later
terminal. The HMI applications that are created in this software are loaded onto the terminal.
FactoryTalk ViewPoint A web server application that lets remote users access and control the HMI application that runs on a 1.2 or later
terminal by using an internet browser.
Alicense is embedded with each terminal that supports a client connection to a terminal.

PanelView Plus 7 Standard
Applications

Windows CE Operating
System

Open Versus Closed System

14

PanelView Plus 7 Standard Machine Edition applications are restricted to these
applications:

Maximum of 100 screens.
Maximum of 500 alarm messages.

One connection or shortcut to a controller by using either RSLinx”
Enterprise or KEPServer Enterprise software.

Only Ethernet communication is supported.

If RSLinx Enterprise software is used, then Ethernet drivers are
supported.

The terminals run the Windows CE operating system. These devices run HMI
applications and offer a desktop with these capabilities:

File transfer protocol (FTP) server
Virtual network computing (VNC) client and server

ActiveX controls — Refer to View FactoryTalk View ME Station
Information on page 74 to view a list of ActiveX controls installed on

terminal.

TIP  Fora complete list of ActiveX controls, go to http://
www.rockwellautomation.com/knowledgebase and search the
Knowledgebase for keywords “ActiveX Support for PanelView Plus
Terminals.

PDF reader
Third-party device support

You can configure a terminal to run an open or closed desktop environment:

e An open system launches the Windows desktop on startup.

e A closed system launches a FactoryTalk View ME application or

FactoryTalk View ME Station on startup. Desktop access is restricted.

All terminals are shipped as closed systems.

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021
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Desktop Access

Start-up Options

EtherNet/IP Communication

Typical Configuration

You can allow or restrict access to the Windows desktop on the terminal. From
the desktop, you can perform system and control panel operations or run third-
party applications. You can even allow access temporarily to perform specific
tasks, then disable desktop access to prevent unauthorized changes.

TIP  All terminals are shipped with desktop access disabled.

Refer to Desktop Access on page 48 for details on how to modify desktop
access.

The terminal can perform one of three actions at startup:
¢ Launch a FactoryTalk View ME HMI application.
e Launch FactoryTalk View ME Station in Configuration mode. This

mode lets you configure terminal settings and start-up options, load
applications to run, and enable or disable desktop access.

e Launch the Windows desktop.

The factory default state and start-up option after a firmware update is to
launch the terminal in Configuration mode. Refer to Configure Start-up
Options on page 53 for details on how to change the start-up option.

PanelView Plus 7 Standard terminals communicate with ControlLogix 5570
and CompactLogix 5370 controllers over an EtherNet/IP connection.

Traditional DLR, linear, and star network topologies are supported. See these
topics for examples:

e Device Level Ring Network Topology on page 38

e Linear Network Topology on page 39

o Star Network Topology on page 40

Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021 15
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Cata|og Number Exp|anation See the table for an explanation of the terminal catalog number.

Bulletin InputType Display Size Display Type Network Power Operating Model - Option
System
| I | I | I (I
2711P-  T=Touch  4=43-in. C=Color 21="Single Ethernetport ~ D=DC 8=Windows(E S= Standard” - B=Nobrand
label

6=>5.7-in. W =Wide aspect-ratio color 22 = Embedded switch/DLR
7=6.5-in.

9=9.0-in.

10 =10.4-in.

12=121-in.

15 =15.0-in.

(1) The standard models support the Windows CE version 6.0 operating system with an FTP server, VNC client server, ActiveX controls, and PDF reader.

Product Selections Table 3 provides a description of the product selections.

Table 3 - PanelView Plus 7 Standard Terminals Product Selections

Cat. No.!" Display Input | Ethernet Ports Memory
Touch Screen Size Type Aspect Pixels Power Single | DLR RAM Nonvolatile
Ratio (Wx H)
2711P-T4AW21D8S 4.3-in. WQVGA 16:9 480x272 DC . 512 MB 512 MB nonvolatile
2711PT4W22085 TET color . ( Appr::f?(;’m oo
2711P-T6(21D8S 5.7-in. VGA 43 640 x 480 . user memory)
2711P-T6022085 TET color
2711PT7C21085 6.5n. VGA 43 640X 480
2711PT7C22085 TET color
2711P-T9W21D8S 9.0in. WVGA 53 800 x 480 .
2711P-TOW22085 TET color
2711PT10C21D85 10.4-in. SVGA 43 800 x 600 .
2711P-T10C22085 TET color
2711PT12W21D85 12.1-n. WXGA 1610 | 1280800 .
2711P-T12W22085 TET color
2711PT15C21D85 15.0-in. XGA 43 1024x768 .
2711P-T15C22085 TET color

(1) Add -B to the end of a catalog number to order a terminal without the Allen-Bradley logo and product identification; for example, 2711P-T9W21D8S-B.

16 Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021
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Accessories Table 4 through Table 9 list accessories for the PanelView Plus 7 Standard

terminals.

Table 4 - Protective Overlays

(at. No. Display Size Touch Input | Quantity
2711P-RGT4S 4.3-in. . 3
2711P-RGT6S 5.7-in. 3
2711P-RGT7SP 6.5-in. . 3
2711P-RGTISP 9.0-in. 3
2711P-RGT10SP 10.4-in. 3
2711P-RGT125P 12.-in. . 3
2711P-RGT155P 15-in. . 3

Table 5 - Power Supplies and Power Terminal Blocks

(at. No. Description Quantity
1606-XLP95E DIN-rail power supply, 24. ..28V DC output voltage, 95 W 1
1606-XLP100E DIN-rail power supply, 24. . .28V DC output voltage, 100 W 1
2711P-RSACDIN DIN-rail power supply, AC-to-DC, 85...265V AC, 47...63 Hz 1
2711P-RTBDSP 3-pin DC power terminal block (black with white labels for +, —, and GND) 10
Table 6 - Mounting Hardware

(at. No. Description Quantity
2711P-RMcs Mounting levers (gray) 12

(1) Catalog number 2711P-RMCS mounting levers are for use only with PanelView Plus 7 Standard terminals. Do not use these
mounting levers with any other PanelView Plus terminals. Do not use black mounting levers; they are not compatible with
PanelView Plus 7 Standard terminals.

Table 7 - SD Cards "

(at. No. Description Quantity
1784-SD1 1GBSD card 1
1784-SD2 2GBSD card 1
1784-SDHC8 8 GB High Capacity SD card 1
1784-SDH(32 32 GB High Capacity SD card 1
2711C-RCSD USB to SD adapter for SD card 1
2711P-RCKS SD cover replacement 3

(1) To reduce the chance of corruption when using SD Cards or USB drives with the terminal, Rockwell Automation recommends
that you use SD Card catalog numbers 1784-SD1 or 1784-SD2.

Table 8 - USB Programming Cable

(at. No.

Description

Length

6189V-USBCBL2

Programming cable that connects the device port of the terminal to a

USB host port of a computer

1.8m(5.9ft)
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Ethernet Cables

18

Table 9 - Battery Replacement

(at. No. Description Quantity
2711P-RY2032 Lithium coin-cell battery, CR2032 equivalent 1
2711P-RYKS Battery cover replacement 3

See the Industrial Ethernet Media Brochure, publication 1585-BR001B, for

recommended Ethernet cables and media solutions.

See the USB to Serial Adapter Quick Start Guide, publication
GMSC10-QS003, for information on USB to serial port adapters.

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021


http://literature.rockwellautomation.com/idc/groups/literature/documents/br/1585-br001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/qs/gmsc10-qs003_-en-p.pdf

Chapter 2

Install the PanelView Plus 7 Standard Terminal

Topic Page
Hazardous Locations 21
Considerations for Mounting 24
Clearances for Mounting 24
Panel Guidelines 24
Panel Cutout Dimensions 25
Prepare for Panel Mounting 26
Mount the Terminal in a Panel 30
Apply the Static Discharge Warning Label 34
Remove and Replace Power Terminal Block 35
Connect Power 36
Connect to a Network 37
Initial Startup 41
Reset the Terminal 41

A\

depend on solid-state electronics.

ATTENTION: Do not use a PanelView™ Plus 7 Standard terminal for
emergency stops or other controls critical to the safety of personnel or
equipment. Use separate hard-wired operator interface devices that do not

The equipment meets the requirements of the standards and ratings that are

listed in Table 10.

Table 10 - ATEX and INMETRO Ratings

ATEX:

EN 60079-0, EN 60079-7,

EN 60079-11, and EN 60079-31
113GD

ExecicllCT4 Gc

ExicllCT4 Ge

Ex tc IICT135 °C (275 °F) Dc IP66
Tamb=0...55°C(32...131°F)
DEMKO 14 ATEX 1302X

IECEx:

IEC60079-0; IEC60079-7; 1EC60079-11;
and [EC 60079-31

136D

ExecicllCT4 G

Ex tc I1ICT135 °C (275 °F) Dc IP66
Tamb=0°C... +55°C(32°F...131°F)
IECEx UL 20.0046X

INMETRO:

ABNT NBR IEC 60079-0;

ABNT NBR IEC 60079-11;

ABNT NBR IEC 60079-8;

e ABNT NBR IEC 60079-31

Ex ecicllCT4 Ge

ExicllCT4 Ge

Ex tcICT135 °C(275 °F) Dc IP66
Tamb=0...55°C(32...131°F)
UL-BR 14.0716X

CCCEx
GB 3836.1-2010; GB 3836.3-2010;

GB 3836.4-2010; GB 12476.1-2013;

GB 12476.5-2013
ExecicllCT4Ge
Ex tc I1ICT135 °C(275 °F) Dc IP66

Tamb =0°C...+55°C(32°F...131°F)
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ATTENTION: Environment and Enclosure

This equipment is intended for use in a Pollution Degree 2 industrial environment, in overvoltage Category Il applications (as
defined in [EC 60664-1), at altitudes up to 2000 m (6561 ft) without derating.

The terminals are intended for use with programmable logic controllers.

This equipment is considered Group 1, Class A industrial equipment according to IEC CISPR 11. Without appropriate precautions,
there may be difficulties with electromagnetic compatibility in residential and other environments due to conducted or radiated
disturbances.

Korean Radio Wave Suitability Registration - When so marked this equipment is registered for Electromagnetic
Conformity Registration as business equipment (A), not home equipment. Sellers or users are required to take
caution in this regard.

ol 7171 78 (AF) AARHJV7IZA & wia} e ALEAE o] HE Fo5HA7] vigt
I EEREE BRI LA Tt R

This equipment is supplied as open-type equipment. [t must be mounted within an enclosure that is suitably designed for those
specific environmental conditions that will be present and appropriately designed to prevent personal injury resulting from
accessibility to live parts. The interior of the enclosure must be accessible only by the use of a tool. The terminals meet specified
NEMA, UL Type, and IEC ratings only when mounted in a panel or enclosure with the equivalent rating. Subsequent sections of
this publication may contain additional information regarding specific enclosure type ratings that are required to comply with
certain product safety certifications.

In addition to this publication, see the following:

« Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1, for additional installation requirements

NEMA 250 and IEC 60529, as applicable, for explanations of the degrees of protection provided by different types of
enclosure

ATTENTION: Wiring and Safety Guidelines
Use publication NFPA 70, Electrical Safety Requirements for Employee Workplaces, IEC 60364 Electrical Installations in
Buildings, or other applicable wiring safety requirements for the country of installation when wiring the devices. In addition to
the NFPA guidelines, here are some other guidelines to follow:
« Employ only qualified electricians to wire the device in accordance with local, state, and national codes.
«  Connect the device and other similar electronic equipment to its own branch circuit.
Protect the input power by a fuse or circuit breaker rated at no more than 15 A.
«  Route incoming power to the device by a separate path from the communication lines.
« Cross power and communication lines at right angles if they must cross.
Communication lines can be installed in the same conduit as low-level DCI/0 lines (less than 10V).

« Shield and ground cables appropriately to avoid electromagnetic interference (EMI). Grounding minimizes noise from EMI
and is a safety measure in electrical installations.

For more information on grounding recommendations, refer to the National Electrical Code published by the National Fire
Protection Association.

20
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Hazardous Locations The following information applies when operating this equipment in

hazardous locations.

When marked, these products are suitable for use in Class I, Division 2,
Groups A, B, C and D; Class II, Division 2, Groups F and G; Class I1I
hazardous locations and nonhazardous locations only. Each product is supplied
with markings on the rating nameplate indicating the hazardous location
temperature code. When combining products within a system, the most
adverse temperature code (lowest “T” number) can be used to help determine
the overall temperature code of the system. Combinations of equipment in
your system are subject to investigation by the local authority having
jurisdiction at the time of installation.

WARNING: EXPLOSION HAZARD
A The following information applies when operating this equipment in hazardous locations.

This equipment is suitable for use in Class |, Division 2, Groups A, B, Cand D; Class II, Division 2, Groups F and G; Class IlI
hazardous locations and nonhazardous locations only.

Do not disconnect equipment unless power has been removed or the area is known to be nonhazardous.

Do not disconnect connections to this equipment unless power has been removed or the area is known to be nonhazardous.
Secure any external connections that mate to this equipment by using screws sliding latches, threaded connectors, or other
means provided with this product.

When installed in a hazardous location, do not open the enclosure, connect or disconnect equipment unless the area is
known to be non-hazardous.

Substitution of components can impair suitability for Class I, Division 2.
Peripheral equipment must be suitable for the location where it is used.

All wiring must be in accordance with Class |, Division 2, Class Il, Division 2, or Class Il wiring methods of Articles 501, 502 or
503, as appropriate, of the National Electrical Code and/or in accordance with Section 18-1J2 of the Canadian Electrical
Code, and in accordance with the authority having jurisdiction.

When used in Class Il and Class Il hazardous locations these products must be installed in a dust tight enclosure in
accordance with Articles 502 and 503 of the National Electrical Code.

For IECEx, ATEX, and INMETRO Zone 2 applications, transient protection shall be provided that is set at a level not exceeding
140% of the peak rated voltage value at the supply terminals to the equipment.

For IECEx, ATEX, and INMETRO applications, mount the display in environments not subject to UV light exposure.
USB device port is for maintenance use only, it is not to be used during normal operation of the device.

Install the display in the cutout of an enclosure by using the provided clamps to compress the bezel gasket to form a seal
against the panel. The gasket seal is permanent for the installation.

Use field/power wiring that is rated to a minimum of 90 °C (194 °F).

Install the display in a location that minimizes the risk of impact from other objects. Do not drop, jolt, or impact the display
during installation.

Mount the display through an enclosure wall with a minimum ingress protection rating of IP54 (Zone 2 applications) and

IP6X (Zone 22 applications), and in an overall environment not exceeding Pollution Degree 2 as defined in IEC 60664-1. The
enclosure must meet Zone 2 and/or Zone 22 ATEX/IECEx requirements depending on area of installation.
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Informations sur l'utilisation de cet équipement en environnements dangereux:

Les produits marqués "CL I, DIV 2, GP A, B, C, D" ne conviennent qu'a une
utilisation en environnements de Classe I, Division 2, Groupes A, B, Cet D ;
Classe II, Division 2, Groupes F et G ; Classe III dangereux et non dangereux.
Chaque produit est livré avec des marquages sur sa plaque d'identification qui
indiquent le code de température pour les environnements dangereux. Lorsque
plusieurs produits sont combinés dans un systeme, le code de température le
plus défavorable (code de température le plus faible) peut étre utilisé pour
déterminer le code de température global du systéme. Les combinaisons
d'¢quipements dans le systéme sont sujettes a inspection par les autorités locales
qualifiées au moment de l'installation.

AVERTISSEMENT : RISQUE D’EXPLOSION
A Les informations suivantes s'appliquent lorsque cet équipement fonctionne dans des zones dangereuses.

(et équipement est utilisable uniquement en Classe |, Division 2, Groupes A, B, Cet D ; Classe II, Division 2, Groupes F et G ; Classe
Il dangereux et non dangereux.

Couper le courant ou s'assurer que la zone est classée non dangereuse avant de débrancher I'équipement.

Couper le courant ou s'assurer que la zone est classée non dangereuse avant de débrancher les connexions de |'équipement.
Fixer tous les connecteurs externes reliés a cet équipement a I'aide de vis, loquets coulissants, connecteurs filetés ou autres
moyens fournis avec ce produit.

Lorsqu'il est installé dans une zone dangereuse, n'ouvrez pas le boitier, ne connectez ou déconnectez pas I'équipement a
moins que |a zone ne soit connue pour étre non dangereuse.

La substitution de composants peut rendre cet équipement impropre a une utilisation en Classe I, Division 2.
Les équipements périphériques doivent convenir a I'environnement dans lequel ils sont utilisés.

Tous les systemes de cablage doivent étre de Classe I, Division 2, Classe II, Division 2, ou Classe Ill conformément aux
méthodes de cablage indiquées dans les Articles 501, 502 ou 503 du Code Electrique National (National Electrical Code) et/ou
conformément a la Section 18-1J2 du Canadian Electrical Code (Code Electrique Canadien), et en fonction de I'autorité de
juridiction.

Quand ces produits sont utilisés dans des environnements dangereux de Classe Il et Classe lll, ils doivent étre installés dans
une enceinte étanche aux poussiéres conformément aux Articles 502 et 503 du Code Electrique National (National Electrical
Code).

Pour les applications en Zone 2 IECEx, ATEX et INMETRO, une protection contre les transitoires sera fournie pour limiter les
surtensions transitoires a 140 % de la tension de créte assignée au niveau des bornes d'alimentation de I'équipement.

Pour les applications [ECEx, ATEX et INMETRO, installer I'afficheur dans des environnements non exposés aux rayonnements
ultraviolets.

Le port pour dispositif USB est destiné a la maintenance uniquement, il ne doit pas étre utilisé pendant le fonctionnement
normal du dispositif.

Installer |'afficheur dans la découpe d'une enceinte en utilisant les fixations fournies pour comprimer le joint de
I'encadrement et assurer I'étanchéité avec la paroi. L'étanchéité du joint doit étre permanente pour I'installation.

Utiliser un cablage de terrain/d'alimentation normalisé pour une température minimum de 90 °C (194 °F).

Installer I'afficheur dans un emplacement qui minimise le risque de choc par d'autres objets. Pendant I'installation,
I'afficheur ne doit pas tomber, subir des secousses ou des chocs.

Monter I'écran dans la paroi d’un boitier ayant un indice de protection minimum IP54 (applications de la zone 2) et IP6X
(applications de la zone 22), et dans un environnement global ne dépassant pas le degré de pollution 2, tel que défini dans la
norme IEC 60664-1. Le boitier doit répondre aux exigences de la zone 2 et/ou de la zone 22 ATEX/ IECEX, selon la zone
d'installation.

22
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As informagoes a seguir aplicam-se ao operar este equipamento em dreas
classificadas.

Os produtos marcados com “CL I, DIV 2, GP A, B, C, D” sao adequados
somente para utilizacao em dreas classificadas de Classe I, Divisao 2, Grupos A,
B, C e D e em dreas nao classificadas. Cada produto ¢é fornecido com marcagoes
na placa de identificagao de classificagiao que indicam o c6digo de temperatura
da 4rea classificada. Ao combinar produtos em um sistema, o codigo de
temperatura mais adverso (nimero “I” mais baixo) pode ser usado para ajudar a
determinar o c6digo de temperatura geral do sistema. As combinagoes de
equipamentos em seu sistema estao sujeitas a fiscalizagao das autoridades locais
com jurisdi¢ao no momento da instalagao.

ATENCAO: Risco de explosio
As informacdes a sequir aplicam-se ao operar este equipamento em dreas classificadas.

Este equipamento é adequado para utilizacdo em dreas dlassificadas de Classe I, Divisao 2, Grupos A, B, Ce D; Classe II, Divisdo 2,
Grupos F e G; e Classe IIl, bem como em dreas ndo dlassificadas.

Nao desconecte 0 equipamento, a nao ser que a alimentacdo tenha sido removida ou a drea seja conhecida como nao
classificada.

Nao desligue as conexdes deste equipamento, a ndo ser que a alimentacdo tenha sido removida ou a érea seja conhecida
como nao dlassificada. Proteja quaisquer conexdes externas a este equipamento utilizando as travas deslizantes, os
conectores com rosca ou outros meios fornecidos com este produto.

Nao abra o invélucro quando instalado em drea classificada. Nao conecte ou desconecte o equipamento a menos que a drea
seja conhecida como drea ndo-classificada.

A substituicao dos componentes pode prejudicar a adequagao para a Classe I, Divisdo 2.
0Os equipamentos periféricos devem ser adequados para o local onde sao utilizados.

Toda a fiacdo deve estar em conformidade com os métodos de fiacao de Classe I, Divisao 2, Classe I, Divisdo 2 ou Classe Il do
artigo 501, 502 ou 503 do Cddigo Elétrico Nacional e/ou em conformidade com a Secdo 18-1J2 do Cddigo Elétrico Canadense
e em conformidade com a autoridade que tiver jurisdicao.

Quando usados nas dreas classificadas de Classe Il e Classe llI, esses produtos devem ser instalados em um compartimento
estanque ao pd, de acordo com os artigos 502 e 503 do Cddigo Elétrico Nacional.

Para aplicacdes em zona 2 IECEx, ATEX e INMETRO, deverd ser fornecida limitacdo transiente na aplicaco que limitar as
sobretensoes transientes a nao mais do que 140% acima da tensao aplicada.

Para aplicacdes IECEx, ATEX e INMETRO, instale a tela em ambientes onde a luz ultravioleta (UV) nao possa influenciar as
partes nao metalicas.

A porta para dispositivo USB destina-se apenas para manutencao e nao deve ser utilizada durante a operacao normal do
dispositivo.

Instale a tela no recorte de um gabinete utilizando os grampos fornecidos para comprimir a junta da moldura e formar uma
vedacdo contra o painel. A junta de vedacao é permanente para a instalacao.

Utilize fiacao de campo/alimentacdo que seja classificada para um minimo de 90 °C (194 °F).

Instale a tela em um local que minimize o risco de impacto de outros objetos. Nao derrube, bata ou cause impacto na tela
durante a instalagdo.

0 display deve ser montado em um invélucro com grau de protecao minimo IP54 quando instalado em dreas que requerem
EPL Gc (Zona 2), e IP6X para EPL Dc (Zona 22). 0 ambiente da instalacdo nao pode exceder Grau de Poluicao 2 conforme
definido pela IEC 60664-1. 0 invélucro deve ser devidamente certificado e atender aos requisitos para EPL Gc (Zona 2) e / ou
EPL Dc (Zona 22), dependendo da instalacao.

The terminals have a temperature code of T4 when operating in a 55°C (131 °F)
maximum ambient temperature. Do not install product in environments where
atmospheric gases have ignition temperatures less than 135 °C (275 °F).
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Considerations for Mounting Consider the following items when mounting the terminal:

Typically, the terminal mounts on the vertical surface of a panel or
enclosure, at a 0° angle, just below eye level.

Mount the terminal at a height suitable for most operators.
Mount the terminal in an area that has good lighting.

Do not mount the terminal where it is exposed to direct sunlight.

Clearances for Mounting Plan for adequate space around the terminal and inside the enclosure for
ventilation and cables. Consider the heat produced by other devices in the
enclosure. The ambient temperature around the terminal must be 0...55 °C

(32...131 °F).

Table 11 - Minimum Required Clearances

Product Area Min Clearance
Top 51mm (2in.)
Bottom 5Tmm(2in.)
Side 25 mm (1in.) on side without an SD card
51 mm (2in.) on side with SD card
Back 0Omm (0in.)
Panel Guidelines Mount the terminals in the door or wall of a NEMA, UL Type, or IP rated
enclosure:

The enclosure must be of type IP20 or greater protection.
Panels must have a minimum thickness of 1.5...4.8 mm (0.060...0.188 in.).

The material strength and stiffness of the panel must be sufficient to
hold the terminal and maintain an appropriate seal against water and
dust.

The panel surface must be flat and free of imperfections to maintain an

adequate seal, and NEMA, UL Type, and IP ratings.
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Panel Cutout Dimensions

Use the template that is shipped with your terminal to mark the cutout

dimensions.

Table 12 - Panel Cutout Dimensions - PanelView Plus 7 Standard Terminals

Terminal Size Input Type Height, mm (in.) Width, mm (in.)
4.3-in. Touch 92 (3.62) 117 (4.61)

5.7-in. Touch 123 (4.84) 156 (6.14)

6.5-in. Touch 142 (5.59) 184 (7.24)

9.0-in. Touch 162 (6.38) 252(9.92)
10.4-in. Touch 224 (8.82) 269 (10.59)
12.7-in. Touch 218(8.58) 312(12.28)
15.0-in. Touch 290 (11.42) 353(13.90)
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Prepare for Panel Mounting Before mounting a terminal in a panel, read this section and the entire

installation procedure on page 30.

IMPORTANT  Use catalog number 2711P-RMCS mounting levers (gray) for PanelView
Plus 7 Standard terminals. Do not use these mounting levers with any other
PanelView Plus terminals. Do not use black mounting levers; they are not
compatible with PanelView Plus 7 Standard terminals.

Mounting levers insert into the slots around the bezel to secure the terminal in

the panel. The number of mounting levers varies by terminal size.

Each slot has six notches with alignment marks that are locking positions for a
mounting lever. The thickness of the panel that you mount the terminal in
determines the locking position that is required to maintain a NEMA, UL

Type, and IP seal.

Table 13 - Mounting Lever Locking Positions

Mounting

Mounting Slot L|e)ve‘rtl‘.ock Panel Thickness Range TGyaPI:CgaJ
osition
1 1.50...2.01 mm (0.060...0.079in.) 16
2 2.03...2.64mm (0.08...0.104in.) 14
3 2.67...3.15mm (0.105...0.124in.) 12
Notch 1 6
4 3.17...3.66 mm (0.125...0.144 in.) 10
Al Mk 5 3.68...4.16 mm (0.145...0.164 in.) 8/9
ignment Marks
6 4.19...480mm (0.165...0.188 in.) 7

Always orient a mounting lever vertically before inserting it into a slot. This
method is the only way to slide the mounting lever knob within the slot for
positioning. After sliding the mounting lever to a specific notch, rotate the
mounting lever toward the panel to lock it in position. The flat side of the
mounting lever must come into contact with the panel.
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Inner notch on mounting lever
shows current lever position.

Knob on reverse side of
mounting lever inserts

into large end of slot. . .
You can use an erasable marker or grease pencil to mark the alignment

marks below the slot for visibility of slot positions.

Initially, you secure the terminal in the panel by sliding each mounting lever to
a position that is one or two notches greater than the final lock position. For
example, if the final lock position is 1, slide each mounting lever to position 2
or 3. Follow the sequence specific to the terminal size shown in Figure 2 on

page 29.

TIP  Ifthelock position s 6, slide the mounting lever to the large end of the slot
orinsertion hole.

Figure 1 on page 28 shows the mounting lever orientation and locking

sequence for a 5.7-in. and 10.4-in. terminal. See Figure 2 on page 29 for locking

sequence and mounting lever orientations for all terminals.
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Figure 1- Mounting Levers Shown in Locked Position

All mounting levers are locked in position 1.This is appropriate for a
panel thickness of 1.50...2.01 mm (0.060...0.079 in.).

The notch shows the locked position.

28 Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021



Chapter 2

Figure 2 - Mounting Lever Orientation and Lock Sequence

4.3-in. Touch - 4 Levers

5.7-in. Touch - 6 Levers
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The box indicates that the levers must be rotated in the IMPORTANT: The mounting lever orientations that are shown are required to maintain
orientation that is shown to avoid interference with NEMA, UL Type, and IP seals. If you require a NEMA, UL Type, or IP seal, do not use a
ports and cables. mounting lever in another orientation than shown.

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021

29



Chapter 2

Mount the Terminalin a The terminals were designed for single-person installation. No tools are
Panel required to mount the terminal. Some tools are required to make the panel
cutout.

Follows these steps to mount the terminal in a panel.

ATTENTION:
A Disconnect all electrical power from the panel before making the panel cutout.

Make sure that the area around the panel cutout is clear and that the panel is
clean of any debris, oil, or other chemicals.

Make sure that metal cuttings do not enter any components that are already
installed in the panel and that the edges of the cutout have no burrs or sharp
edges.

Failure to follow these warnings can result in personal injury or damage to
panel components.

1. Use the cutout dimensions on page 25 to cut an opening in the panel.
2. Verify that the sealing gasket is present on the terminal.

This gasket forms a compression-type seal. Do not use sealing
compounds.

° o ° Gasket

3. Center the terminal in the panel cutout.

4. See Table 13 on page 26 to get the final lock position of the mounting

levers for the panel thickness.

5. See Figure 2 on page 29 to determine the mounting lever orientations

and lock sequence for your terminal size.
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6. Secure the terminal in the panel.

TIP  The mounting levers for PanelView Plus 7 Standard terminals are gray,
similar to the color of the bezel (catalog number 2711P-RMCS).

Do not use black mounting levers; they are not compatible with PanelView
Plus 7 Standard terminals.
a. Verify the orientation of the mounting lever.

The direction that you rotate each mounting lever is different for
cach terminal size.

= ——

]
|

o Q

b. Hold the first mounting lever in the locking sequence vertical to the
slot and insert its knob into the large end of the slot.

s ——

fllrrw {

c. Slide the mounting lever to a notch that is one or two positions
greater than the final locking position for your panel thickness.

If the final locking position is 1, slide the mounting lever to position 2
or 3.

2
\

Yoo,

3
/

TIP  To mark the alignment marks for visibility of the slot positions and

to mark the final lock position, use an erasable marker or grease
pendil.
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32

d. Rotate the mounting lever until its flat side comes in contact with the
panel.

IMPORTANT Do not use tools or excessive force to rotate the mounting lever. The
mounting levers are rotated and secured by hand.

TIP  Abroken mounting lever does not damage the terminal.

If a mounting lever is over torqued, the lever is designed to break
off the pin. This breakage helps to prevent damage to the
terminal bezel. If a pin is broken, turn the mounting lever over
and use the other pin to continue the installation. See Figure 2 on
page 29 for details and restrictions.

e. Repeat steps a through d for the remaining mounting levers.

7. Adjust each mounting lever to its final position by using the same
locking sequence in Figure 2 on page 29.

a. Unlock mounting lever one in the sequence by rotating it away from

the bezel.
Q% oo
=11}

b. With the mounting lever positioned vertically to the slot, slide the
mounting lever to the final locking position in Table 13 on page 26.

c. Carefully rotate the mounting lever back toward panel.

d. Repeat steps a through ¢ to lock the remaining mounting levers in
their final position.
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8. To make sure each is in the correct locked position, inspect all mounting
levers.

ATTENTION: All mounting levers must be in the correct locked
A position and follow the correct lever installation sequence to provide

an adequate gasket seal between the terminal and the panel.

Rockwell Automation assumes no responsibility for water or

chemical damage to the terminal or other equipment within the
enclosure because of improper installation.

The notch on the outside of mounting lever shows its locked position.

This view shows that the mounting levers are locked in position 1.

= »)]
L ]
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| s

Terminal with dual Ethernet
ports shown.
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Apply the Static Discharge

Warning Label IMPORTANT  Rockwell Automation recommends applying the static discharge warning
label for all hazardous location applications according to the instructions
below. If the intended application requires ATEX or IECEx certification, the
static discharge warning label MUST be applied according to the instructions
below.

A static discharge warning label is included in the box with the PanelView Plus
7 Standard terminal. If required for your installation, this label must be affixed
to the panel in a location that is visible to the operator.

/I WARNING

POTENTIAL ELECTROSTATIC CHARGING
HAZARD — SEE INSTRUCTIONS

Atencdo: Risco potencial de carga eletrostatica,
veja o manual de instrugdes

Follow these steps to apply the static discharge warning label.
1. Identify alocation for the static discharge warning label that is visible to
the operator during operation.
2. Clean the desired install location with isopropyl alcohol.

3. Remove the backing from the static discharge warning label and apply
the label to the desired location.

4. Verify that operator visibility to the static discharge warning label is not
obstructed at any time during operation.
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The product has a three-pin terminal block for power connections. You can

Remove and Replace Power

Terminal Block

remove the terminal block for ease of installation, wiring, and maintenance.

A\

WARNING: Explosion Hazard
If you connect or disconnect wiring while the power is on, an electric arc can

occur. This arc can cause an explosion in hazardous location installations. Make
sure that the power is off and the area is nonhazardous before proceeding.

Failure to turn power off can result in electrical shock or damage to the
terminal.

Use a 0.6 x 3.5-mm flat blade screwdriver for terminal block wiring.

Table 14 - Wire Specifications for Power Input Terminal Block

Wire Type Dual-wire Size" Single-wire Size | Strip Length Screw Torque
Stranded or solid 03...1.3mm? 03...21mm? . .
w90 (194 OF) 22...16 AWG (2214AWG) 7mm (028|n) 0.56 Nem (50|b‘|n)

(1) Two-wire maximum per terminal.

To remove the power terminal block, follow these steps.

1. Loosen the two screws that secure the terminal block.

< >
[

TP

Terminal with dual Ethernet
ports shown.

2. Gently pull the terminal block away from the connector.

To install the power terminal block, follow these steps.

1. Press the terminal block onto the connector until seated.

A\

2. Tighten the two screws that secure the terminal block to the connector.

ATTENTION: Do not use excessive force to press the DC terminal
block into position. The DC terminal block is keyed to fit the DC
connector. If the terminal block does not fit into the connector, verify
that you have the correct DC terminal block. See Table 5 on page 17.
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Connect Power

36

The terminals have a 24-V DC non-isolated power supply at these power
ratings:

e 24V DC nominal (18...30V DC)

e 35 W maximum (1.46A at 24V DC)

polarity. Connecting DC+- or DC- to the earth ground terminal can damage
the terminal. Connecting AC power, or more than 30V DC, can also damage
the terminal.

c ATTENTION: The power supply is internally protected against reverse

The terminals support operation from a safety extra low voltage (SELV) or
protective extra-low voltage (PELV) 24V DC power supply. Supported power
supplies include catalog numbers 1606-XLP95E, 1606-XLP100E, and
2711P-RSACDIN.

your installation. The SELV and PELV power sources provide protection so
that under normal and single fault conditions, the voltage between
conductors and earth ground does not exceed a safe value.

c ATTENTION: Use a SELV or PELV supply as required by local wiring codes for

To power the terminal from the same power source as other equipment, use a

DC power bus.

To connect the operator terminal to a DC power source, follow these steps.
1. Verify that the wiring is not connected to a power source.

2. Strip 7 mm (0.28 in.) of insulation from your power supply wires.

20 mm

| 7mm
=]

3. Secure the DC power wires to the marked terminals (+ and -) on the
terminal block.

Terminal with dual Ethernet
ports shown.

DC+ DC- GND

4. Secure the earth ground wire to the GND terminal on the terminal

block.

The GND terminal must be connected to a low-impedance earth
ground.
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Connect to a Network

L

Link 2 Link 1

Terminal with dual Ethernet
ports shown.

This connection is required for noise immunity, reliability, and
Electromagnetic Compliance (EMC) with the European Union (EU)
EMC Directive for CE marking conformance. This connection is
required for safety by Underwriters Laboratory (UL).

c ATTENTION: The earth ground connection to ground is mandatory.

IMPORTANT  Secure the power cable to prevent these actions:

Vibration at the connector.

Pulling when the panel door is opened and closed, or when
personnel are working inside the panel.

5. Apply power to the operator terminal.

The Ethernet port or ports connect to controllers on an EtherNet/IP™
network by using standard Ethernet connections. These types of networks are

supported:

e Device Level Ring Network Topology on page 38

e Lincar Network Topology on page 39

e Star Network Topology on page 40

Each of these EtherNet/IP network topologies supports applications that use
Integrated Motion over an EtherNet/IP network, if necessary. See the
EtherNet/IP Embedded Switch Technology Application Technique,
publication ENET-APOQOS, for more information.

IMPORTANT  Terminals can have dual Ethernet ports, but only one device IP address.

Ethernet Ports

The Ethernet ports have one or two 10/100Base-T connectors for network
communication and supports MDI/MDI-X connections and DLR network
topology as indicated by the DLR network icon.

The terminal connects to an EtherNet/IP network by usinga CATS, CATSE,
or CAT6 twisted-pair, Ethernet cable with RJ45 connectors.

PR - -

|= S

y ’
. Link 2 il = L
ﬁ " .ﬁ Ethernet Ports rgil Link 1

) b !
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IMPORTANT  To help prevent accidental disconnection of the Ethernet cable, follow these
steps:

- To minimize vibration at the connector, and reduce the chance that
personnel working inside the panel can accidentally disconnect the
cable, secure the Ethernet cable.

«  To prevent pulling on the cable when the panel door is opened and
closed, do not install the Ethernet cable too tightly. Leave some slack in
the cable.

The maximum cable length between the Ethernet ports and a 10/100Base-T
port on an Ethernet hub (without repeaters or fiber) is 100 m (328 ft).

WARNING: Do not connect or disconnect any communication cable with

A power applied to this device or any device on the network. An electric arc
can cause an explosion in hazardous location installations. Make sure that
the power is off or the area is nonhazardous before proceeding.

Table 15 - Ethernet Connector Pinout

Connector Pin Pin Name
View of RJ45 1 D+
Connector
1 3 2 1D-
TTTTTIT] ; e0T
E\‘—l ] 4 Unused
\ ( 5 Unused
Green Yellow
Status Status 6 RD-
Indicator  |ndicator
7 Unused
8 Unused
Shield connection No direct connection
(AC coupled to chassis GND)

The Ethernet port has two indicators that provide the status of activity.

Table 16 - Ethernet Status Indicators

Indicator Color Description
Link integrity Green On, when a link is present.
Activity Yellow Blinks when activity is detected on Ethernet link.

Device Level Ring Network Topology
A DLR network is a single-fault tolerant ring network that is intended for the
interconnection of automation devices. This topology is also implemented at

the device level. No additional switches are required.

TIP  ADLR network has supervisor nodes and ring nodes. The PanelView Plus 7
Standard terminal operates only as a ring node on the network.
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Only PanelView Plus 7 standard terminals with two Ethernet ports, for
example, catalog number 2711P-T10C22D8S, operate on a DLR network.

DLR network topologies automatically convert to linear network topologies
when a fault is detected. The conversion to the new network topology
maintains communication of data on the network. The fault condition is
typically detected and corrected.

For more information on DLR network topology, refer to EtherNet/IP

Embedded Switch Technology Application Guide, publication ENET-AP00S.
Figure 3 - PanelView Plus 7 Standard Terminal in a DLR Network
Computer Connected Via a

1783-ETAP EtherNet/IP Ta - i
1769-L13ERM-BB1B Control ystem p 1756-ControlLogix Controller

PanelView Plus 7 Standard
Terminal Connected Via Two
Ethernet Ports

PowerFlex® 755 Drive Connected
Via a 1783-ETAP EtherNet/IP Tap

[ v A—

Kinetix® 6500 Drives I BE DR ; F
with Motors . g
I ﬂ
(]
1734-AENTR POINT 1/0™ Adapter 1794-AENTR FLEX™ 1/0 Adapter
with POINT I/0 Modules with FLEX 1/0 Modules

Linear Network Topology

A linear network topology is a collection of devices that are daisy-chained
together across an EtherNet/IP network. Devices that can connect to a linear
network topology use embedded switch technology to eliminate the need for a
separate switch, as required in Star network topologies.

TIP  The PanelView Plus 7 Standard terminal with one Ethernet port can be
attached only at the ends of the linear network.
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Figure 4 - PanelView Plus 7 Standard Terminal at the End of a Linear Network

) 1734-AENTR POINT I/0 Adapter
1794-AENTR FLEX I/0 Adapter with POINT 1/0 Modules

with FLEX 1/0 Modules

Computer PanelView Plus 7 Standard Terminal

1769-L27ERM-QBFC1B Kinetix 350 Drive Connected Kinetix 350 Drive Connected
Control System Via a 1783-ETAP EtherNet/IP Tap Via a 1783-ETAP EtherNet/IP Tap
Star Network Topology

A star network topology is a traditional EtherNet/IP network that has
multiple devices that are connected to each other via an Ethernet switch.

Figure 5 - PanelView Plus 7 Standard Terminal Connected Via a Stratix 6000 Switch

1769-L27ERM-QBFC1B
Computer Control System

PanelView Plus 7 Standard Terminal

] | : ™ .
Kinetix 350 Drive Dg Stratix 6000™ Switch

1734-AENTR POINT I/0 Adapter

Kinetix 350 Drive with POINT /0 Modules
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Initial Startup

Reset the Terminal

The first time that you start the system, the terminal goes through its start-up
sequence and launches FactoryTalk® View ME Station in Configuration mode.

FarfriryTalk Vivw ME Slation

Curmonl applicalion

Load Application Rum Application Appication Sellings
[F1] 1F21 | [F3]
J |
e Dedete Log Files Oves
Te m-.i::;. inges BT b
1Fs1 (O]
1P Adck: 165.254.148.37 Heset Exit

(] (51
Subnit: 255.255.0.0 |

Dievice: PP 12600 { ‘

To change the action that occurs at startup, press Terminal Settings, then tap
Startup Options. You can configure one of these options:

e Launch a FactoryTalk View ME HMI application.
e Launch FactoryTalk View ME Station in Configuration mode (default).
e Launch the Windows desktop.

EXAMPLE Terminals are initially shipped with desktop access disabled. You can
configure your terminal to allow desktop access.

For more information on how to change the start-up option and desktop

access, see Chapter 3, Configure Terminal Settings.

There are several ways to restart the terminal without having to disconnect and
reapply power:

e From FactoryTalk View ME Station Configuration Mode, tap Reset.

e From the terminal desktop Start Menu, choose Programs>Restart
System.

¢ To access Maintenance Mode, follow these steps.
a. Plugin a USB keyboard.

b. Press and hold the white box that appears in the bottom left corner
when the terminal is booting up.

Refer to Maintenance Mode Operations on page 145 for details on how to

restart the terminal from Maintenance Mode.
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Notes:
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Configure Terminal Settings

Topic Page Topic Page
FactoryTalk View ME Station 43 Display Settings 63
Terminal Settings 45 Input Device Settings 65
Soft Keyboard 46 Configure Print Options 67
Load and Run an Application 47 Configure Diagnostics 69
Desktop Access 48 Check Integrity of Application Files 70
Configure Start-up Options 53 View and Clear the System Event Log n
Configure Controller Address 56 Enable or Disable the Alarm Display 71
Configure Ethernet Settings 56 Display System Information 72
Modify Device Name of Terminal 60 Time and Date Settings 75
Copy Files on Terminal 61 Regional Settings 77
Delete Files from Terminal 62

FactoryTa'k View ME Station  FactoryTalk® View ME Station is the runtime environment of the terminal.
This environment lets you configure start-up options, load and run HMI
applications, adjust terminal settings, access the Windows desktop, and
perform other terminal operations.

When you reset the terminal, one of these actions occurs depending on the
configured start-up option:

e FactoryTalk View ME Station launches in Configuration mode. This
mode is the initial default.

o FactoryTalk View ME .mer application runs.

e Windows desktop launches.

IMPORTANT - Toaccess Configuration mode from an HMI application on the terminal,
press Goto Configuration Mode. This button is added to application
screens in FactoryTalk View Studio software during application
development. The application stops running but is still loaded.

- Ifyour application does not have a Goto Configuration Mode button,
refer to Enter Configuration Mode on Startup on page 54 for details on
how to access Configuration mode.

+ Toaccess Configuration mode from the Windows desktop, double-click
the FTViewME Station icon 5] .
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Figure 6 - FactoryTalk View ME Station Dialog Box

FactoryTalk View ME Station

Current application:
Objects 5 Screen Demo.rmer
Load Application Run application Application Settings
[F3]
. . Delete Log Files Oes
Terminal Settings Before Running
[F5] @ Mo
Device: PYPILs12600
IP Addr: 160.254.148.37 Reset Ezit
[F7] XTI
Subnet; 255,255.0.0
Table 17 - Terminal Operations
Press To

Load Application [F1]

Open a dialog box where you select a .mer application to load in the
device. You must load an application before you can run it.

The name of the loaded application appears under Current
Application.

Run Application [F2]

Run the .mer application that is loaded in the terminal.

Application Settings [F3]

Open a menu of application-specific settings, such as device shortcuts
defined for the loaded .mer application. Device shortcuts are
read-only.

For example, CLX is the device shortcut for a ControlLogix® controller.

Terminal Settings [F4]

Open a menu of options to modify terminal settings.

Delete Log Files Before Running [F5]

Toggle between Yes and No.
Select Yes to delete all data log files, alarm history, and alarm
status files before running the application.
Select No to run the application without deleting log files.

Reset [F7]

Reset the terminal and launch an HMI application, FactoryTalk View
ME Station software, or the Windows desktop. The action that occurs
depends on the configured startup-option.

Exit [F8]

Exit FactoryTalk View ME Station. If desktop access is allowed, you can
access the desktop.

Device, IP Addr, Subnet
(display only)

Identifies the device name, IP address, and subnet of the terminal on a
connected Ethernet network.

The network information is updated every 60 seconds. If the terminal
is disconnected from the network, the IP address and subnet appear
as0.0.0.0.
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Terminal Settings

The terminal has settings that you can adjust that are not specific to the
application.

1. Press Terminal Settings from the FactoryTalk View ME Station dialog
box.

v A 2. Select an option by touching the up and down cursors.

o 3. Press Enter to access selected function.
Cument spphcstion Diagnostice Setup
acts 5 Geraan Dama mat Display
[ovmzm—r Diesktop Access Setup A
File Managerment
Lot i Acpietn S s ot Font Linking
[nput Devices
Fil= Integrity Check
Metworks and Communications
S Print Setup
exmial Setion Startup Options .
" Systern Event Log .
System Information k
Dok Pk 12600 Tirne/Date/Regional Settings
F sy 165011877 II)F;I! i::] \
Subret: 2755 25500
-+~
¢t [ it v v s - e |
Close
[F8]
Table 18 - Terminal Settings
Select This Option If You Want To
Alarms (lose the alarm display on the terminal when an operator acknowledges the newest alarm. By default, the alarm display is closed.
Diagnostics Setup Edit the location where diagnostic messages are saved and determine what kind of messages are saved.
Display Adjust the brightness of the display, configure the screen saver, and enable/disable the touch screen cursor.
Desktop Access Setup Allow or restrict access to the desktop. Set or reset the desktop password.

File Management

Copy application files and font files to the terminal, an SD card, or a USB drive. You can also delete application files, log files, and font
files.

Font Linking

Link a font file to a base font loaded on the terminal.

Input Devices

Configure settings for the keypad, attached keyboard, mouse, or touch screen, including touch screen calibration. You can also choose
between a pop-up character input or pop-up keyboard for string input.

File Integrity Check

Check the integrity of the .mer application file and runtime files by logging details to a file integrity check log. You can view and clear
this log at any time.

Networks and Communications

Configure Ethernet and other communication settings for an application.

Print Setup Configure settings that are used to print displays, alarm messages, or diagnostics messages that the application generates.
Startup Options Specify whether the terminal launches the desktop, an application, or FactoryTalk View ME Station Configuration mode on startup.
System Event Log Display system events, and clear events from the log.

System Information

Display power, battery, and memory details for the terminal. You can also view the firmware revision for FactoryTalk View ME Station,
and other software that is loaded on the terminal. Technical support information.

Time/Date/Regional Settings

Set the date, time, language, and numeric format that is used by terminal and applications.
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Soft Keyboard When you activate a data entry field on the terminal, a keyboard opens. For
fields that require only numeric values, 0...9 and the decimal is enabled.
Deyice Name E
|PVPIU512600 |
2 3 4 5 =) 7 =] =] a =
q W =) r & y u i o 1] [ ]
a s d i g h ] 3
z ® E W b n m I i
SHF CAP SPACE Backspace
select L -> ‘ ‘ * * Enter ESC

Table 19 - Soft Keyboard Controls

Select this key:

To:

SHF

Switch keys between their shifted and unshifted state.

CAP

Switch between lowercase and uppercase characters.

SPACE

Enter a space between characters in the display area.

Backspace

Delete the previous character (to the left of the cursor) in the display area.

Select

Enter a selected character into the display area.

Left, right, up, down arrow

Select the character to the left, right, above, or below the currently selected
character.

Enter

Accept the entered characters and return to the previous dialog box.

ESC

(ancel the current operation and return to the previous dialog box.

Follow these steps to enter characters in the display area above the keyboard:

1. Select a character on the keyboard by touching a key.

2. Press Enter when done to exit the keyboard.

46 Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021



Chapter 3

Load and Run an Application To run a FactoryTalk View ME .mer application on the terminal, you must first
load the application. You can load the application from internal storage
(nonvolatile memory) in the terminal, an SD card, or a USB drive.

Factrep! 48 View ME Bration

Cumenl spghestn

[Frms e e

B 19254 1.5

Sukren; 2200

LN En e e

@ Intermal Storage

Load
() External Storage 1 [gza]

() External Storage 2

Cancel
[F&1

Follow these steps to load and run an application on the terminal.

1.

Press Load Application from the FactoryTalk View ME Station dialog
box.
To select the location of the file to load, press Source:
e Internal Storage — nonvolatile memory of the terminal.
o External Storage 1 — an SD card is loaded in the card slot.
o External Storage 2 — a USB drive is loaded in the USB host port.
TIP  The path for Machine Edition files on the terminal is
My Device\Application Data\Rockwell Software\RSViewME\Runtime.

The path for Machine Edition files on the SD card or USB drive is
\Rockwell Software\RSViewME\Runtime.

To select a .mer file from the list, use the up and down cursor keys.
To load the selected application, press Load.

You are asked if you want to replace the current communication settings
of the terminal with the settings defined in the application.

Select Yes or No.
e To use the communication settings in the application, select Yes.

The application settings replace the communication settings that are
configured for the terminal.

e To use the communication settings of the terminal, select No.

The application loads and its name appears at the top of the FactoryTalk
View ME Station dialog box.

To run the application that loaded, press Run Application on the
FactoryTalk View ME Station dialog box.
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TIP  Applications generate log files. You can delete log files from the FactoryTalk
View ME Station dialog box before running the application. Delete log files
to reclaim memory in the terminal.

Refer to Run the Loaded Application on Startup on page 55 to set the
application to run on startup or reset.

Desktop Access You can allow or restrict access to the desktop on the terminal. From the
desktop, you can perform system and control panel operations. You can allow
access temporarily, then disable desktop access to prevent unauthorized
changes.

TIP  Terminals are shipped from the factory with desktop access disabled.

With restricted access, you must enter a password to access the desktop. Each
terminal has a default password and a challenge question.

Default Password Credentials Values

Password password (case sensitive)
Challenge question What is the opposite of lock?
Challenge answer unlock (case sensitive)

IMPORTANT  Rockwell Automation recommends that you change the default password
and challenge question and answer to something unique for your
installation.

Enable Desktop Access

Follow these steps to enable desktop access.

1. Press Terminal Settings, then choose Desktop Access Setup.
2. Toselect Allow, press Desktop Access.
The Enter Password dialog box opens.

Each time that you change desktop access from disallow to allow, you
must first enter a password. The initial default password is ‘password.

To type the password, then press Enter, press Password.

4. To return to Desktop Access Management, press Enter again.
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Desktop Access Management:

Bl

Desktop Access

() Disallowe

Set Password
[F3]

Reset Password

[F4] -

Password status:

Challenge question:

Password is not set

Challenge is not set

oK
[F7]

Cancel
[ra]

Notice the password is no longer set.

5. To exit terminal settings and return to the FactoryTalk View ME Station
dialog box, press OK to exit Desktop Access Management, then Close.

6. To access the desktop, press Exit.

When desktop access is enabled, you are not required to enter a
password.

Disable Desktop Access

IMPORTANT  To restrict desktop access, the start-up option must be set to either Go to
Configuration Mode or Run Current Application. See page 53 for details.

To restrict desktop access requires that you define a desktop password and
challenge question:

¢ The password lets you access the desktop from FactoryTalk View ME
Station when pressing Exit.

e The challenge question and response lets you change the password with
the Reset function.

Follow these steps to disable desktop access.

1. Press Terminal Settings, then choose Desktop Access Setup.
2. Press Desktop Access and select Disallow.

The Set Password button is enabled.
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Desktop Access Management

(O Al

Desktop Access
[F2]

(%) Disallowr:

Paggwiord status:  Password s not set
Set Password

[F3]

Challenge gquestion:  Challenge is nat set

Reset Password
[F4]

OK Cancel
[F7] [F8]

IMPORTANT Ifan error message displays, you can change the startup option to
Go to Configuration Mode or Run Current Application.

You cannot restrict access to the desktop if Startup Options is
configured for Do not start FactoryTalk View ME Station.

3. Refer to Set a Desktop Password on page 51 to define a new password

and challenge question.
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Set a Desktop Password

IMPORTANT  When you restrict access to the desktop, you must define a new password
and challenge question.

Follow these steps to define a new desktop password.

1. Press Set Password.

The Desktop Access Set Password dialog box opens.

Set Password Password: | |
Set Challenge Challenge question:

[F3]
Set Response Challenge response:

0K Cancel
[F7] [F8]

2. Press Set Password, enter an 8...20 character password, then press Enter.

IMPORTANT  You must correctly enter this password before accessing the
desktop.

3. Press Set Challenge to enter a challenge question that you must correctly
respond to when resetting the desktop password.

4. Press Set Response to enter a response to the challenge question, then
press Enter.

S. Press OK.

The Desktop Access Management Dialog shows that a password and
challenge question are set.

6. Press OK to return to terminal settings.

IMPORTANT  Secure your password and challenge question for future use. To clear and
reset the password, you must correctly respond to the challenge question. If
you forget the response, the only way to clear the password is to restore the
factory default settings on the terminal. See Factory default on page 145.
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52

Desktop Access Management

Desktop Access
[F2]

() Alow

(3) Disallow

Set Password
[F3]

Reset the Desktop Password

To clear and change the current password, you must correctly respond to the
current challenge question. If you do not remember the response, you must
restore the terminal to its factory defaults. Refer to Maintenance Mode
Operations on page 145.

IMPORTANT  You can reset the password and challenge questions if access to the desktop

is restricted or set to disallow.

Password status:  Password

Challenge question:  Challen

/V

[
[F7]

Follow these steps to reset the desktop password.

Press Reset Password from the Desktop Access Management dialog box.

Desktop Access Password Reset.

Challenge question: |What is the terminal name? |

Answer Challenge

Challenge response: | |

Passyword statuis: Password s set
Clear Password

Challenge status; Challenge is set

Close
[F8]

Press Answer Challenge and enter the correct response to the current
challenge question.

Press Clear Password to clear the current password and challenge
question.

The dialog box shows the updated status of the password and challenge

information.

Press Close.

Refer to Set a Desktop Password on page 51 to set a new password and
challenge question.

After clearing the password, you must set a new desktop password or
change the desktop access to “Allow’
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Configure Start-up Options

You can specify what action the terminal takes on startup or a reset.

This Start-up Option Performs This Action Typical System
Do not start FactoryTalk View | Launches the Windows desktop on startup. Open
ME Station

Go to Configuration Mode Launches FactoryTalk View ME Station in Configuration Closed
mode on startup. This mode is the initial, factory default
setting.

Run Current Application Runs the FactoryTalk View ME application that is loaded in | Closed
the terminal on startup.

IMPORTANT  When desktop access is restricted, the start-up option must be set to Run
Current Application or Go to Configuration Mode (default). See page 48 for
details on how to allow or restrict desktop access.

Disable FactoryTalk View ME Station on Startup

To launch the desktop on startup, you must disable FactoryTalk View ME
Station.

TIP  You can also launch the desktop by pressing Exit on the FactoryTalk View
ME Station dialog box.

Follow these steps to disable FactoryTalk View ME Station on startup.

1. Press Terminal Settings, then choose Startup Options.

FactoryTalk View,ME Station Startup

Do not start FactaryTalk View ME Station

O Go to Configuration Mode

On Startup Configuration Mode Options
[F1] [F21

Run Current Application

Run Options
[F3]

OK Cancel
[F7] [Fa]

2. Press On Startup until ‘Do not start FactoryTalk View ME Station’ is
selected.
TIP  Desktop access must be set to allow or you get a warning. See
enable desktop access on page 48.

3. DPress OK.
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Enter Configuration Mode on Startup

Follow these steps to launch FactoryTalk View ME Station in Configuration
mode on startup.

1. Press Terminal Settings, then choose Startup Options.

2. To select Go to Configuration Mode, press On Startup.

3. To view or change optional settings, press Configuration Mode Options.

FactoryTalk View ME Station Startup

O Do not start FactoryTalk Wiew ME Station

(%) &0 to Configuration Mode

Configuration Mode Options
On Startup Configurati ce Options
[F1]
Run Current Applcation \ Load Current
Application
Run Options [F1]
IFa] Ona
0K Cancel Replace RSLinx O e
[F71 [F8] Enterprise
Communications
F2
[F2] "o

&9start |[ D FactoryTak View ME Station Vavee L[] 20

0K Cancel
[F7] [F8]

4. 'To specify whether you want to load the current application on startup,
press Load Current Application.

5. To specify what configuration settings are used when the loaded
application is run, press Replace RSLinx® Enterprise Communications:

e To use the RSLinx communication settings in the terminal, select

No.

e To replace the terminal settings with the communication settings in
the application, select Yes. Any changes to RSLinx device addresses or
driver properties on the terminal are lost.

6. To return to the previous dialog box, press OK.

7. To return to terminal settings, press OK.
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Run the Loaded Application on Startup

Follow these steps to run the FactoryTalk View .mer application that is loaded
in the terminal on startup.

Press Terminal Settings, then choose Startup Options.
To select Run Current Application, press On Startup.
To view or change optional settings, press Run Options.

If the application is not loaded, the options are disabled.

FactoryTalk View ME Station Startup

O Go to Configuration Mode

Run Current Application

On Startup Configuration Mode Options
[F1] [F2]

Run Options
[F3]
() es

Do not start Factory Talk Wiew ME
O 0 not start Factory Tal 1By Run Uptiong
Replace RSLinx O e
Enterprise
Communications
[F1] @ho

Delete Log Files
On Every Power Cycle
[F2]

0K
[F7]

(3)Mo

Cancel
[ra]

0K Cancel
[F71 [F8]

Press Replace RSLinx Enterprise Communications to specify what
configuration settings are used when running the application:

e To use the RSLinx communication settings in the terminal, select
No.

e To replace the terminal settings with the communication settings in
the application, select Yes. Any changes to RSLinx device addresses or
driver properties on the terminal are lost.

To specify what action to take with the log files on startup, press Delete
Log Files On Every Power Cycle:

o To delete all log files (data, alarm history, alarm status) generated by
the terminal before running the application, select Yes. The files are
deleted from the system default location.

e To retain all log files, select No.
To return to the previous dialog box, press OK.

To return to terminal settings, press OK.
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COnfigure Controller Address To configure communication information for your application and controller,

use RSLinx Enterprise software.

TIP  You can also configure communication information for your application
and controller by using FactoryTalk View Studio software.

To edit the device address of the controller, follow these steps.

1. Press Terminal Settings, then choose Networks and
Communications>RSLinx Enterprise Communications.

RSLin% Enterprise Configuration

Edit. Device Address

E-virtual Backplane
. =No Devices=
E-Ethernet
BE 1 756-ERET/ A, 131
=-1756-217/B
[=-1756-L63 LOGIS563, 0
“-OF1 Point-to-Paint

Device Mame:

1795-ENBT /A

|131‘200.55.54

OK Cancel

[F71 [F8]

Edit Dri
[F=

Edit Device
[F1]

2. Select the controller in the tree.

To view the device name and current address, press Edit Device.
4. To modify the address, press Device Address.

The input panel opens with the current address.
5. Enter the address in the input panel and press Enter.

6. Press OK.

Updates do not take effect until the terminal is restarted.

COnfigure Ethernet Settings The terminal has a built-in Ethernet driver. You can modify the following

Ethernet information for your device:
o IP address of terminal on network, including link speed
e Device name that identifies terminal on network
e User name and password to access network resources

¢ Enable or disable either Ethernet port to configure for DLR, star, or
linear network topologies
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KS82411: Micrel k58841 Etharnet Driver

Set the Ethernet Address of the Terminal

Some networks automatically assign an IP address to Ethernet devices if
dynamic host configuration protocol (DHCP) is enabled. IF DHCP is
disabled, you can manually enter an IP address.

To view or enter an IP address for your terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and
Communications>Network Connections>Network Adapters.

1P Address

. [F1]

10.00.02.179

Subnet Mask [255.255.254.0
[F21

Gateway
731 10,90.82.1

Mac ID:

IP Address Use DHCP
[F1] ‘ / ‘ [F4]

Name Servers

00-00-bc-31-30-26
\ Yes
N S — e Q
[F21 @

IP Address
[F2]

/H Settings Those
[F3] [F8]
Gateway
| || |
Mac 1D: 0K Cancel
71 [r8]
‘
2. To view or modify the IP address, press IP Address.

3. To enable or disable DHCP assignment of addresses, press Use DHCP.

o If DHCP is enabled or set to Yes, IP addresses are automatically
assigned to newly attached devices on the network.

o If DHCP is disabled or set to No, you can manually enter the IP
address. Press IP Address, Subnet Mask, and Gateway to enter IP
formatted addresses.

TIP - IP Address — The format of the IP address is xxx.xxx.xxx.xxx; for
example, 192.168.124.96. The first set of decimal numbers is in the
range 1...255; the last three sets are in the range 0. .. 255. The default
is 000.000.000.000.

« Subnet Mask — Address must be identical to the server subnet mask.
« Gateway — optional address.
« MACID - read-only field.

4. Press OK when done.

If prompted, reset the device from the FactoryTalk View ME Station
dialog box.

5. Press Close.
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Set the Ethernet Link Speed

You can change the rate and mode for how data is transmitted on the Ethernet
network. The default setting is Auto. The Auto option automatically
configures the speed of the device to match the speed on the local network.

TIP  The Auto option is preferred because it determines the actual speed and
duplex setting of the connected device on the Ethernet network.

If you select a manual option, make sure that the speed and duplex setting
for the connected device on the Ethernet network is identical. If the
settings are not identical, there can be decreased network performance
and errors.

1. Press Terminal Settings, then choose Networks and
Communications>Network Connections>Network Adapters.

Network Adaptors

Name Servers IP Address Settings Close
[F1] [F2] [F3]1 [F8]

2. To access the Ethernet link settings, press Settings.

3. To change the rate that data is transmitted at over the Ethernet network,
press Ethernet Configuration.

4. 'To return to the Network Adapters dialog box, press OK.

Configure the Ethernet Ports

To configure the Ethernet ports of the terminal, follow these steps.
1. Press Terminal Settings, then choose Networks and
Communications>Network Connections>Network Adapters.
2. To access the Ethernet link settings, press Settings.

3. To enable or disable the ports that you want to use for your network
configuration, press Ethernet Link1 and Ethernet Link2.
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Network Adaptors

1 Ethernet
4
Name Servers IP Address Settings Close
[F1] [F2] [F3] [F8]

4. To select Auto, press Ethernet Configuration.
5. To save the configuration, press OK.

6. For the changes to take effect, restart the terminal.

You can also configure the Ethernet ports as a system default for a closed

system. See Configure the Ethernet Ports on page 113.

Name the Server Addresses

You can name the server addresses for the EtherNet/IP network adapter. These
addresses are automatically assigned if DHCP is enabled for the adapter.

1. Press Terminal Settings, then choose Networks and
Communications>Network Connections>Network Adapters.

Name Servers
Network Adaptors

‘ Primary DNS
[F1]

Primary WINS
[F2]

—_— Secondary DNS
[F3]

Secondary WINS
[F4]

/’7
| ||

Name Servers IP Address Settings Clo
[F1] [F21 [F31

i3]

Ok Cancel
[F7] [Fa]

2. Press Name Servers.
3. To enter a corresponding name server address, press a button.

4. Press OK when done.
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Mod|fy Device Name of Each terminal has a unique name that identifies it on the network.
Terminal

1. Press Terminal Settings, then choose Networks and
Communications>Network Connections>Device Name.

2. To edit the default device name, press Device Name.

Deyice Name

Device Name
PvP12600
[F1] I

Device Description
[F2]

IRU\:kWEH Automation 2711P-T10C21D88

OK Cancel
[F7] [F8]

TIP  The device name has 1...15 characters:

« Thefirst character must be an upper or lowercase lettera...z,A...Z
« The other characters canbea...z,A...Z0...9, or - (hyphen).

3. To modify the description for the device, press Device Description.

TIP  The description is a maximum of 50 characters. The default description is
Rockwell Automation plus the device catalog number.

4, Press OK.
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Copy Files on Terminal

You can copy FactoryTalk View ME .mer application files or font files between
nonvolatile memory of the terminal and a USB drive, or SD card.

1. Press Terminal Settings, then choose File Management>Copy
Files>Copy Applications or Copy Fonts.

@ Initernal Storage

Source Destination
ks O External Storage 1 [F2]

O External Storage 2

e —

bJects Demod.rmer

Cancel
[F8]

2. To select the location of the file you want to copy, press Source:
e Internal Storage — nonvolatile memory of the terminal.
o External Storage 1 — SD card that is loaded in card slot of terminal.
e External Storage 2 — USB drive that is loaded in USB host port of
terminal.

Select a file that appears in the list for the selected storage area.

4. Press Destination on the same dialog box.

() Internal Storage
Des;:;lf]tiﬂ" @) External Storage 1

() External Storage 2

Copy
[F2]

Cancel
[F8]

5. To select the storage location to copy the file, press Destination.
The destination must be different than the source location.
6. To copy the selected file to the target location, press Copy.

If the file exists, you are asked if it is okay to overwrite the file. Respond
by selecting Yes or No.

TIP  Ifyou are saving files to the terminal, be sure to save the .mer files to
My Device\Application Data\Rockwell Software\RSViewME\Runtime\
and save font files to \Rockwell Software\RSViewME\Fonts\.
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Delete Files from Terminal You can delete FactoryTalk View ME application .mer files or font files that

reside in nonvolatile memory of the terminal, a USB drive, or an SD card.

1. Press Terminal Settings, then choose File Management>Delete
Files>Delete Applications or Delete Fonts.

@ Internal Storage.

Source Delete
i () External Storage 1 [F2]

() External Storage 2

Copy of Ohjects S Screen Demo. mer
Chjects 5 Screen Dermno.mer
(Cbijects Dermnod.mer

Close
[F&8]

2. To select the storage location of the application or font file you want to
delete, press Source:

e Internal Storage — nonvolatile memory of the terminal.
o External Storage 1 — SD card that is loaded in card slot of terminal.

o External Storage 2 — USB drive that is loaded in USB host port of
terminal.

Select a file that appears in the list for the selected storage area.

4, Press Delete.

5. Select Yes or No when asked if you want to delete the selected
application or font file.

Delete Log Files

You can delete log files, alarm history files, and alarm status files from the
System Default location of the terminal. The application generates the files
during runtime.

1. Press Terminal Settings>File Management>Delete Files>Delete Log
Files.

You are asked to confirm the deletion of the files.

Do you want to delete the FactoryTalk View ME Station Log Files?
2. Select Yes or No.

Log files not in the System Default location are not deleted.
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D|Sp|ay Settings For the terminal display, you can change its brightness, configure the screen

saver, or disable the screen cursor.

Adjust Display Intensity
You can adjust the intensity of the backlight in 10% increments from 1...100%.
At 0%, the backlight is minimally visible. You can use the default intensity of

100% or adjust the intensity for runtime operations.

1. Press Terminal Settings, then choose Display>Display Intensity.

(3) Runtime

Startup

100% Intensity
[F1] () Defalt

oK Cancel ‘
[F7] [Fa]l

2. To switch between Default intensity and Runtime intensity, press
Startup Intensity.

o Ifyouselect Runtime, the start-up screens use the runtime intensity.

o Ifyouselect Default, the start-up screens use the default setting of
100%.

3. Increase or decrease the intensity for runtime operations by pressing the
up or down cursors.

4. Press OK when done to save changes.
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Configure the Screen Saver

A screen saver image appears on the terminal display when no user activity is
sensed for a certain time. The default idle time is 10 minutes. You can adjust
the idle time and intensity level of the screen saver, disable the screen saver, or
disable the screen saver image.

1. Press Terminal Settings, then choose Display>Screen Saver.

Iritonty

() sabiect
- ()5 minutes

To!
| (3 20 it

Saver | 15 bt
[F1] | Screen Saver (%) Enabled
| (20 it Image
-w )25 it F1 () Disabled

(130 mintes

OK Cancel
[F71 [Fg]
Achvanced Cancel
7 ]

2. To change the idle period for activating the screen saver, press Screen
Saver.

To disable the screen saver, select Disabled.

3. To increase or decrease the brightness intensity of the screen saver, press
the up and down cursors.

4. To access the screen saver image setting, press Advanced Settings.

a. To disable or enable the current screen saver, press Screen Saver

Image. See page 91 for details on how to change the screen saver
image.

b. To return to the Screen Saver dialog box, press OK.

5. To exit and return to terminal settings, press OK.

Disable the Screen Cursor

The terminal has a screen cursor that you can disable or enable.
1. Press Terminal Settings, then choose Display>Cursor.

@ ves
) Mo

Enable Cursor
[F11

0K Cancel
[F71 [F8]

2. To disable or enable the cursor, press Enable Cursor.

3. To exit and return to terminal settings, press OK.
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|nput Device Settings You can adjust settings for input devices that are used by the terminal including

the touch screen and string entry popup.

Calibrate the Touch Screen

To calibrate the touch screen, follow these steps.

IMPORTANT  Use a plastic stylus with a minimum tip radius of 1.3 mm (0.0571in.) A
stylus is more precise than a finger and also protects the screen.

1. Press Terminal Settings, then choose Input Devices>Touch
Screen>Calibration.

Carefully press and briefly hold stylus on the center of the target.
Repeat as the target moves around the screen.

+

2. Follow the instructions on the screen.

When the calibration is complete, a message appears to indicate the
measurement of new calibration settings. You can do one of the
following:

e To register saved data, press the screen.

e To cancel saved data and keep the current settings, wait for 30
seconds.
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66

Set the Double-tap Sensitivity for a Touch Screen

You can set and test the sensitivity of both speed and physical distance between
touch screen presses.

TIP  The process is identical to set and test the sensitivity of mouse clicks. To
adjust the sensitivity of mouse clicks, press Terminal Settings, then choose
Input Devices>Mouse.

1. Press Terminal Settings, then choose Input Devices>Touch
Screen>Double Tap Sensitivity.

Touch Screen Double-Tap

Double Tap Sensitivity

Double-tap the button to set sensitivity for both the speed and physical
distance between taps,

Double-tap this button to test the sansitivity,

Test

0K Cancel
[F71 [F8]

2. To set the sensitivity of touch screen presses, double-tap Set.
3. To test the sensitivity of touch screen presses, double-tap Test.
The Test button reverses its foreground and background colors.

4. Press OK when done.

Change the Popup for String Entry

You can use a string popup for character input instead of the popup keyboard
or input panel.

1. Press Terminal Settings, then choose Input Devices>String Popup.

Invoke pop-up character input O es
instead of pop-up keyboard.
[F1] No

0K Cancel
[F71 [F8]

2. To select the preferred method for character input, press ‘Invoke pop-up
character input instead of pop-up keyboard.

3. Press OK.
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Configure Print Options

You can configure settings for print displays, alarm messages, or diagnostic
messages from FactoryTalk View ME applications. The setup for print displays
and messages is the same. Advanced settings are different.

PanelView Plus 7 Standard terminals support selected printers. For a list of

supported printers, go to http://www.rockwellautomation.com/
knowledgebase and search the Knowledgebase for keywords ‘Printers

Supported on PanelView Plus’

Printer installation is plug-and-play. Supported printers are automatically
mapped to the appropriate driver. Printers that do not configure automatically
to the appropriate driver can be installed manually.

Follow these steps to access the print setup.

1. Press Terminal Settings, then choose a Print Setup> option:
o Alarm Print Setup
e Diagnostic Setup
e Display Print Setup
The Print Setup dialog box shows installed printers that are available to

the FactoryTalk View ME application. The list of printers that shows
depends on what printers you install.

The terminals are not shipped with pre-configured printers so initially
the dialog box is empty.

Settings [?'7(]

[F4] [re]

Advanced

Cancel

2. Select an installed printer.

TIP  The printer that you select must be in the control panel Printers applet.
A failed attempt to install a printer is reported in the system event log.

Use the control panel in Windows Explorer to install a printer that does not
install automatically.
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3. To access these options, press Advanced Settings:
o Options for print displays include print orientation, draft mode, and
color.

e Options for print diagnostic and alarm messages determine when to
print messages that are sent to the network or USB port.

() Specified nurmber of messages

Print Messages
?;'f]f (O 500 messages or timeout period, whichever is first

® Specified nuMber of Messages or timeout period, whichever;
iis first i

Number Of Messages Timeout Period
IF31
G0 168 hoLrs
0K Cancel
[F7] [F8]
Print Messages After Default Value Example
Specified number of messages 60 messages When the queue has 60 messages, the messages are printed regardless of

how long they have been in the queue.
You can change the number of messages.

500 messages or timeout period, whichever is 168 hours (7 days) If the queue has 350 messages after 168 hours, the 350 messages are
first printed.

You can change the timeout period.
Specified number of messages or timeout period, | 60 messages If the queue has 60 messages after 24 hours, then the 60 messages are
whichever is first. 168 hours (7 days) printed.

You can change the number of messages and the timeout period.

For example, the number of messages is set to 75 and the timeout period is
set to 48 hours.

- Ifthe queue has 75 messages after 24 hours, then the 75 messages are
printed before the set timeout of 48 hours.

- Ifthe queue has 15 messages after 48 hours, the 15 messages are printed
after the set timeout period.

4, Press OK when done.

5. To return to terminal settings, press OK.
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COnfigure Diagnostics You can log diagnostics to a remote computer for troubleshooting.
To configure and forward diagnostics to a computer, follow these steps.

1. Press Terminal Settings, then choose Diagnostic Setup.

A list of diagnostic nodes appears.
TIP  Toaccess Remote Log or Message Routing setup, select the node

then press Edit.
Diagrnostics Setup
£} Destination Setup
© L FT View Diagnostics List A
Address
IF11 255,255 255,255
Edit
[F1]
Port
[F2] 4445

The Remote Log destination forwards messages to a Windows computer that
runs diagnostics. The IP address and port number identify the computer.

Field Description Valid Values
Address [P address of the remote Windows computer. XXX XXX XXX XXX
Port The port that is used to communicate with the remote Windows computer. | 4445 (default)

Select Message Routing to access the following dialog boxes:
e Remote Log

e FactoryTalk View Diagnostics List

Each dialog box shows a list of messages that can be sent to a destination.
Cursor to a message, then press On/Off to enable or disable the message.
Messages with checked boxes are enabled. Messages with cleared boxes are

disabled.

Operator Error
Operator Warning
Operator Info

Operator Audit A
Engineer Error
Engineer Warning
Engineer Info
Engireer Audit
Dewveloper Error
Developer Warning v
Developer Info
Developer Audit
Securs Errar
Secure Warning
Secure Info
Secure Audit

COODDD DO RRSRERIR

Onjotf
IF11 0K Cancel

Audit Message Logging lets you log messages as Audit or Information.
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Check Integrity of
Application Files

70

It is good practice to check the integrity of the .mer application that is loaded
in the terminal and the runtime files. Errors, warnings, and information
messages are logged to a file. You can view the logand clear items from the log.

TIP  Runtime files enable applications to run on the terminal. If the terminal is
not functioning correctly, a review of the logs can identify an errorina
runtime file.

1. Press Terminal Settings, then choose File Integrity Check.

@ Yes
Enable Check of the MER
[F1]
(@L:
(@) fes
Enable Check of Runtime Files
(@L:)
View Log (1]:4 Cancel
[F3] [F7] [F8]

2. Press cither of the Enable options to disable integrity checks of the .mer
application or the runtime files.

Integrity checks are automatically performed on the application .mer file
and runtime files. If you disable either of these functions, the files are not

checked and the log file is not updated.
3. DPress OK to save changes.

Follow these steps to view the log generated by runtime files.

1. Press View Log from the File Integrity Check dialog box.

File Integrity Check Log -

7/20/2010 2:44:47 AM - CRC ERROR.: history
I7§20/2010 2:44:47 &M - CRC ERROR: embeddad.alm
Clear all More Details Close
[F1] [F2]1 [Fa]

2. To display details for that event, select an event and press More Details.
3. To clear all details from the log, press Clear All

4. To return to previous dialog box, press Close.
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View and Clear the System
Event Log

Enable or Disable the Alarm
Display

The System Event Log displays warnings, errors, and events logged by the
terminal. The log provides a time stamp of when each event occurred and text
that describe the event. If the event log is full when a new event occurs, the
oldest entry is removed to accommodate the new event.

System Civent Log

7 0524 P, MErceoft (R) Wirdows CE (R ) 5.00 0000 Rital. &
Bl 05:24 PM, The Everst ko sérvices wis sharbed
11:44 AM, CPU Temperaturalid=2}
4 AM, A
2014, WM, The Event log service was started,
NEI 2004, 123333 AM, CPU Tomporature(id=2) at 25 C, State=LOW LE ¥
Clear All Mure Details Gl
Ir1] 21 o]

51t [T FactoryTak: view ME Station e L 1024 7M | 2y

1. Press Terminal Settings>System Event Log.
To display details for the event, select an event then press More Details.

To clear all events in the log, press Clear All

L

Press Close.

The terminal displays each alarm as it occurs in the alarm display or alarm
banner. When the operator acknowledges the most recent alarm, the alarm
display closes or remains open. The default is to close the alarm display.

1. Press Terminal Settings, then choose Alarms.

Close Alarm Display When Newest iES
Alarm Acknowledged

[F1] Ono

0K Cancel
[F71 [F8]

2. To toggle between Yes or No, press ‘Close Alarm Display When Newest
Alarm Acknowledged.

e Yes closes the alarm display when the newest alarm is acknowledged.

e No leaves the alarm display open when newest alarm is

acknowledged.
3. Press OK.
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D|Sp|ay System Information You can view terminal and firmware revision information for software that is

installed on a terminal.
View Terminal Information

You can view the following information:
o Total power on time in minutes
e Battery voltage and state
e Memory that is allocated and in use

e Random access memory (RAM) usage during runtime
To view status information for your terminal, follow these steps.

1. Press Terminal Settings, then choose System Information>Terminal
Information.

Terminal Informatian

Total power on time (minutes): Battery voltage:
139690 3.20
Battery state:
GOOD
Memony: 440008 KB RAM 79128 KB Flash
Memory Allocation Runtime RAM Usage Close
[F1] [F2] [F8]
N
e Battery voltage must be at least 2.75V DC.
Battery State Description
GOOD Good battery condition.
FAILING Low battery. Replace the battery.
BAD Battery is missing or bad. Replace the battery.
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2. To view information for the Program RAM and Available Flash
(nonvolatile) memory, press Memory Allocation.

Memory Allocation

3. To return to previous dialog box, press Close.

4. To view the RAM used by the application at runtime, press Runtime
RAM Usage.

This information can be helpful if you are troubleshooting problems
that are related to RAM usage.

Runtime RAM Usage

Show RAM Usage
[F1]

Cancel
[F8]

5. To return to the previous dialog, press OK.

6. Press Close until you return to terminal settings.
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View FactoryTalk View ME Station Information

You can view firmware and version information for components that are
installed on your terminal and access technical support information.

1. Press Terminal Settings, then choose System Information>About
FactoryTalk View ME Station.

Firrmwatre Wersion
RSLinx Enterprise 560, 14, 28 ‘
FactoryTalk Services Platform 2.60.0.12
KEPware 5.7.608. 0
Forts 1.1.0.0
FactonyTalk “dewPaint 2.60.3. 16
Rockwell Automation Activel - Case Statement F.0.13.0
Rockwell Automation SctiveX - Custem PopUp T.00120
Rockwell Automation #ctivel - Data StorePlus F.0.13.0
Rockwell Automation ActiveX - Display P T.oo120 .
Rochwell Automation Active - Email Sender F.0013.0
Rockwall Automation fctive - IPInfo F.0013.0
Rockwell Automation Activel - Macrohultiplexer T.0013.0
Rochwell Automation fetivel - MacnaTan F.00120
Rochkwell Automation ActiveX - Proglaunch 7.0013.0
Rockwell Automation Activel - Recipe? 7.0.13.0
Rockwell Automation #ctivel - ResetPassword F.0.13.0
Rockwell Automation ActiveX - SBCP F.0.13.0
Rockwell Automation Activel - Terminallnfo 7.0.13.0
Rockwell Automation SctiveX - Terminaliake Up T.00130
Rockwell Automation fctivel - WiebBrowser F.0.13.0
Technical Support Close
[F1] [Fs]

2. To display the support phone number and website, press Technical
Support.

3. Press Close until you return to terminal settings.
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Time and Date Settings

You can change the time zone, date, time, and regional settings for terminal

operations.

TIP  Set the time zone before you change the current date and time on the

terminal.

Change the Time Zone on the Terminal

You can view or modify the current time zone on the terminal. Time zones are

installed with the operating system. A change to the time zone adjusts the
current time and date to match the time zone.

The clock records the time when files are created or modified on the terminal.

You can change the time and time zone.

1. Select Terminal Settings, then choose Time/Date/Regional

Settings>Time Zone.

(GMT-03:00) Greenland
(GMT-03:00) Montevideo
(GMT-03:30) Newfoundland
(GMT-04:00) Asuncion
(GMT-04:00) Atlantic Time (Canada)
(GMT-04:00) Georgetomn, La Paz, San Juan
(GMT-04:00) Manaus
(GMT-04:00) Santiago
(GMT-04:30) Caracas
(GMT-05:00) Bogota, Lima, Quito
(GMT-05:00) Eastern Time (US & Canada)
(GMT-05:00) Indiana (East)
(GMT-06:00) Central America
(GMT-06:00) Central Time (US & Canada)
(GMT-06:00) Guadalajara, Mexico City, Monterrey
(GMT- Elﬁ 00) Saskatchewan
(GMT-07:00) Arizona
(GMT-07:00) Chihuahua, La Paz, Mazatlan
00 ) Mountain Time (US & Canada

007 Tijuana, Baia California

Daylight
Savings

DK
TF1] [F7]

2. Press the up or down cursor to select a time zone.

Daylight Saving Time is enabled for all time zones except Japanese
(Japan does not support Daylight Saving Time). The clock is adjusted
automatically when Daylight Saving Time changes.

3. Optionally, press Use Daylight Savings to enable or disable Daylight

Saving Time for a time zone.

Automatically adjust clock for daylight savings.

Use Daylight Yes
Savings

[F1] Otia

Changes made wil not be saved until you press the OK button on the Time Zone screen.

Changes are not permanent until you close the Time Zone dialog box.

4. Press Close when done.

5. To return to the previous dialog box, press OK.
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Change the Current Date on the Terminal

To adjust the date on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Date.

| 2014 | ] | 18

Year Month Day
[F1] [Fz] [F3]

0K Cancel
[F7] [F&]

2. Press Year, Month, and Day to change the current values above the
button:

e Year is four digits in the range 1980...2099
e Month isin the range 1...12
e Dayisin the range 1...31 and validated by month

3. Press OK when done.

Change the Current Time on the Terminal

To adjust the time on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Time.

Enter time in 24 hour format:

‘ 13 41 22

Seconds
[F3]

Minute
[F2]

Hour
[F1]

OK Cancel
[F71 [F8]

2. To change the current values, press Hour, Minute, and Seconds:
o Hour range is 0...23 (24-hour format)

e Minute and second range is 0...59

3. Press OK when done.
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Regiona' Settings You can change the display format for dates, times, and numerics to match the
standards of a country or region. Languages are installed with the operating
system. Before changing regional settings, you must select a language.

To select a language that is installed on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Language.

Murneric Format - AT
Long Date Format inese (Hong kong S.A.R. ~
Short Date Farmat A Chinese (Marau 5.4.R.)
Tirme Format (Chinese (People's Republic of China)
(Chinese (Singapore) A

(Chinese (Taiwan)
————————— |English (Australia)
Enalish (Belize)
Enalish (Canada)

T English {Caribbean)
v English (Ireland)
English (Jamaica) v
English (Mew Zealand)
English (Republic of the Philippines)

English (South Africa)

English (Trinidad and Tobago)
h (Unit cl

English (Zimbabwe)

French (Belgiurm)

French (Canada)

French (France) M

Current Language:

English (United States) (United States), 1033

Close
[F8]

Ok Cancel
[F71 [F8]

2. Select a language by pressing the up and down cursors.

3. DPress OK.

The selected language shows under Current Language on the Regional
Settings dialog box.

Change the Decimal Separator

You can change the decimal separator that is used in numeric formats for the
selected language. The default separator is a period.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Numeric Format.

Decimal

[F1]

The default separator is shown.

2. Enter a maximum of three characters for the new separator.

3. Press OK.
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Change the Time Format for a Language

To change the format of the time for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Time Format.

Sample: 1

The current time appears in the selected format.

53:09 PM
AM Symbol - Time Format
i | Am | ir)
() hurnmss tt
PM Symbol
[F‘;T . () hhemmiss tt
() Himmiss
() HHimm:ss
Separator I:l
[F3]

OK
[F7]

Cancel
[Fe]

2. To adjust the formats, press the appropriate selections.

The sample format changes as you make selections.

Field Description Example
Time Format h:mm:ss tt (default) 7:23:02 AMor 1:13:31 PM
12-hour h = 12-hour time display, no leading zero 11:43:59 AM
tt =AM or PM symbol
hh:mm:ss tt 07:23:02 AM or 01:13:31PM
hh = 12-hour time display with a lead zero 11:43:59 PM
tt=AM or PM symbol
Time Format H:mm:ss 7:03:42 or 1:13:32
24-hour H = 24-hour time display, no leading zero 23:43:59
HH:mm:ss 07:03:42 0r 01:13:22
HH = 24-hour time display with a lead zero 23:43:59
AM Symbol Characters to indicate AM. If the time formatissettoa | AM (default)
12-hour time display (h:mm:ss tt or hhimmss tt), you | 12 character max
can modify the AM symbol.
PM Symbol Characters to indicate PM. If the time formatissettoa | PM (default)
12-hour time display (h:mm:ss tt or hhimmss tt), you | 12 character max
can modify the PM symbol.
Separator Characters that separate fields in time format. : (default)
3 character max
3. Press OK.

78
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Change the Short Date Format for a Language

To change the short date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Regional Settings>Short Date Format.

Sample:  9A7/2014

(OLEI
Omydfyy 'T
(O ey
O mmajeidfyyyy
O yyimmidet
O wyyy-ba-cid
O dd-imamayy

[F71 [F8]

0K ‘ Cancel

2. To change the short date format, press Format.
The date updates in the Sample area as you change formats.
3. To change the character between date elements, press Separator.

The separator can be three characters. The default separator is — or /.

4, Press OK when done.

Change the Long Date Format for a Language

To change the long date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional
Settings>Regional Settings>Long Date Format.

Sample: Wednesday, September 17, 2014

dclcid, MMMM dil, yyy
Format [@L R
[F1] ()il el MM, gy

O dd MMM, yyyy

0K Cancel
[F71 ‘ [F8]

2. To change the long date format, press Format.
The date updates in the Sample area as you change formats.

3. Press OK when done.
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Notes:
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Windows Operating System

Topic Page
Operating System Features 81
Windows Explorer 84
Taskbar 84
Soft Input Panels 84
Windows Control Panel 85
Backup and Restore 86
Display Properties 920
Hardware Monitor 92
Logo Manager 9%
User Accounts 96
Services 98
Network Server Configuration 98
System Information m
Touch Properties 15
PDF Reader 116

0perating System Features The PanelView™ Plus 7 terminal runs the Microsoft Windows CE version 6.0
operating system (OS) providing the following features:

Command shell
Command processor
Console window
Windows Explorer shell
Common dialog box
Control panel

Network user interface
Soft keyboard input panels
PDF reader

Mouse and touch screen support with right-click support.

TIP  Touch the screen for 1 second or longer for a right-click.
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VNC server and client viewer

IMPORTANT  The terminal distributes two VNC client viewers:

Vncviewer.exe is in the /Windows folder on the terminal
desktop. To connect to, view, and control a PanelView Plus 7
terminal, deploy this viewer to a personal computer.

Another viewer on the terminal lets you establish a VNC
connection to another PanelView Plus 7 terminal. To access this
viewer, click Start>Programs>VNC Viewer.

Application Support

The Windows CE operating system provides the following application
support:

NET Compact Framework, version 3.5 or later

C++ libraries and runtimes

Component services DCOM/COM/OLE

Message queueing MSMQ

MSXML, version 3.0 or later

Microsoft foundation classes (MFC) for devices, version 9.0 or later
Active template library (ATL)

ActiveSync

Cabinet (CAB) file installer/uninstaller

ToolHelp application programming interface (API)

Error reports (generator, transfer driver, control panel)

Scripting Support

The Windows CE operating system supports these scripting features:

Batch/Command (BAT and CMD files)
CS-Script

e JScript

Network Support

The Windows CE 6.0 operating system supports these network features:

Winsock support

Network utilities — ipconfig, ping, route
Network driver architecture (NDIS)

Windows networking API/Redirector

Wired Local Area Network (LAN), 802.3, 802.5
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Server Support

Table 20 lists the servers that support the Windows CE 6.0 operating system.

Table 20 - Windows CE 6.0 Server Support

Default -

Server State Description

Web server Enabled The web server delivers content, such as web pages, by using the HTTP protocol
over the web.

FTP server Enabled File transfer protocol (FTP) is a standard network protocol that is used to
exchange files over the Internet (TCP/IP-based network).

UPnP server Enabled Universal plug and play (UPnP) is a set of networking protocols that lets devices
install and connect to a network.

File server Disabled A network protocol that provides shared access to files, printers, serial ports,
and miscellaneous communication between computers on a network.

VNCserver Disabled Virtual network computing (VNC) is remote-control software that makes it
possible to control another computer over a network connection. Keystrokes
and mouse clicks are transmitted from one computer to another, over a
network.

ViewPoint Enabled A web server application that provides remote users access via a web browser

server to the FactoryTalk® View ME HMI application that is running on the terminal.
ViewPoint software is a Rockwell Automation® product.
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Windows Exp'orer From the desktop, you can access Windows Explorer in several ways:
e Double-click the My Device icon.
My Device e Choose Start>Programs>Windows Explorer.
[Fle edit view so ravortes | | [« [#][7][X[W][E~ w2][x]
AddresslMy Dewice v
B R b B o o |9
{2pplication; My Metwork  Program Files  Temp VFS windows Control Printer
Data Docurnents Parel

A few folders contain items specific to the PanelView Plus 7 Standard terminal.

Folder Content

Application data Contains FactoryTalk View ME application files.
Path: \Application Data\Rockwell Software\RSViewME\Runtime

VS (virtual file system) Contains firmware files and backup/restore files for the current system image.
Paths: \VFS\Platform Firmware and \VFS\Backup & Restore

Taskbar From the taskbar, you can access the Start menu, device IP information, the
current language and time, input panels, and open programs.

o [erE 5w ] A

To turn the taskbar on or off, choose Start>Settings>Taskbar and Start Menu,
then clear or check the Auto Hide checkbox.

TIP  Touch the bottom of the display to recover the taskbar when in Auto Hide
mode.

Soft |nput Panels | f The operating system offers different input panels for entering data. You can

access these input panels from the taskbar or the control panel. From the
taskbar, click the input panel icon and choose the onboard keyboard that you
want to use:

e CHT Chajei IM (Chinese)

e CHT Phonetic IM (Chinese) E:I S:ZJ:;E T
e Keyboard (small keyboard) kKeyboard

o LargeKB (large keyboard) = ;a;g;a:i o

e MS Kana IM (Japanese) MS Roma T4

e MS Roma IM (Japanese) m

¢ Hide Input Panel (closes the keyboard) oo LB z2e am (5] 2

TIP  Theinput panel icon changes depending on which input panel you select.
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Windows Control Panel

Applications in the Windows control panel let you view and configure system
and terminal settings. For example, you can monitor hardware performance,
calibrate the touch screen, or adjust screen saver settings.

TIP  Most terminal settings are also available in FactoryTalk View ME Station
Configuration mode.

The language of the control panel applications is based on the language set for
the operating system. English is the defaul.

You can access the control panel in several ways:
e Choose Start>Settings>Control Panel.

e Open My Device on the desktop, then double-click Control Panel.
This chapter covers control panel applications specific to the

terminal.
B
HE & 2 b = gl 2 P =
oW g i r- .‘.ﬂ -2 3
Backup &  Certificates  Date/Time Dialing Display Errar Hardware  Input Panel  Intermet Keyboard
Restare Reporting Monitor Options
- 2 i P 9 @€
@ O e B & @ 2
Logo Mouse  Metwork and  Owrer Password PC Printers Regional Remove Server
Manager Dialup Ca... Connection Settings Programs Config
- 7 )
2 S 32 Y Jo
Services Storage Systemn Terminal Touch User waolume &
Manager Server Clie... Accounts Sounds
i{fstavt 118 My Deviee Iz control Panel v LE] 452 aM 3] A

TIP  From the View menu, you can change the size of the icons or see a brief
description of each.

TIP  Many control panel applications have scroll bars to view information on a
smaller display, however, most examples show the full view for clarity.

Backup & Restore E]
Backup | Restare

Select backup attributes

»

will backup Advanced Metwaork & Display Settings if

Select file to save backup to... v
< >
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Backup and Restore

86

The Backup and Restore application lets you copy the current system image on
H the terminal, then restore that image to the same terminal or other terminals.

Fackup & This function is useful if you want to clone a system image to multiple

Restore & e rminals.

TIP  You can back up a system image to a USB drive or SD card. Rockwell
Automation recommends using a USB drive or SD card with a minimum of
1 GB of available space. For applications with a large file system, use a
minimum of 2 GB of available space.

A typical backup includes the following:
o File system
o Firmware image
e Windows registry

¢ Optional user configuration data

You can include user configuration data in the backup by selecting the
Advanced Network & Display Settings checkbox in the Backup & Restore

dialog box.
Table 21 - Advanced Network and Display Settings
Setting Description
Ethernet network « DHCP-enabled or fixed IP address

« Primary and secondary DNS
« Primary and secondary WNS
« Speed and duplex settings

USB network USB IP address and subnet mask, Gateway, DHCP-enabled or fixed IP address
Network Device name
Display « Display brightness

« Screen saver dimmer timeout

Perform a Backup

Follow these steps to perform a backup.
1. Insert a USB drive or SD card into the appropriate slot on the terminal.

H 2. In the control panel, double-click the Backup & Restore icon.

Backup & Restore ﬂ

Backup | Restare

Select backup attributes

Wil backup Advanced Metwork & Display Settings if checked

Select file to save backup to...

3. Click browse ... on the Backup tab.
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Browse E IE m’ 2
q_2] 4USB STORAGE

- Rockwel Software
ckup 09-07-14.pvb

— o~
Mamel_|backup 09-07-14.p  Jype: |PV Backup Files v

4. Select the target location for the back-up file:
e USB Storage if you are using a USB drive
e Storage Card2 if you are using an SD card

5. Type a name for the back-up file.
Back-up files have the .pvb file type.

6. Click OK.

Backup & Restore

Backup | Restore

Select backup attributes

Advanced Metwork & Display Settings

Will backup Advanced Metwoark & Display Settings if checked

Select file to save backup to...

I\UL—“-B STORAGE \backup 09-07-14. pvby pvb

i

7. Click Backup to start the process.

A progress bar shows the status of the operation. The backup can take a
few minutes. You receive notification when the backup completes.

Success

Backup was successfully completed

8. Click OK.
If the file exists, you are asked if you want to overwrite the current file.

9. To close the Backup & Restore dialog box, click Exit.

TIP  You can verify the .pvh file was successfully created when you double-click
My Device and select the target location for the backup. If the .pvb file was
not successfully created, use a USB drive or SD card with more available
space.

Rockwell Automation recommends using a USB drive or SD card with a
minimum of 1 GB of available space. For applications with a large file
system, use a minimum of 2 GB of available space.
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Restore a Back-up Image

Follow these steps to restore or clone a back-up image to storage device.

1. Insert the USB drive or SD card into the appropriate slot of the target

device.
2. In the control panel, double-click Backup & Restore.
ki
ackup& Backup | Restare
i Restore |

Select file to restore from

Attributes contained within this backup

Restore

3. Click the Restore tab.

4. To select the back-up file to restore, click ... (browse).

wrowse | 2] [ ]
(3] 4 USB STORAGE

Rockwell Software
ckup 09-07-14.pwh

Name@ﬂg-ﬂ?-m.p flal=H IPV Backup Files v

5. Select the location of the back-up file:

e USB Storage if you are usinga USB drive
e StorageCard2 if you are using an SD card
6. Select the .pvb back-up file to restore.
7. Click OK.

Backup & Restora
Backup | Restore |

Select file to restore from

|'\,LJSE: STORAGE \backup 02-07-14. b vk

Attributes contained within this backup

Advanced MNetwork & Display Settings

Contains Advanced Network & Display Settings If checkad——}_

D e ]

: Restore

8. Click Restore.

The restore automatically includes advanced network and display
settings if you selected this option when performing the backup.

9. To start the restore process, click Yes.
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The terminal starts the restore process that takes a few minutes.

JANE]

QUALITY

IMPORTANT Do not remove the USB drive, SD card, or power off the terminal during a
restore. This action can corrupt the firmware,

If the restore fails, reset the terminal from the maintenance menu.
Refer to Maintenance Mode Operations on page 145 for details.

When the restore completes successfully, the terminal restarts.
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Display Properties

Use Display Properties to control the desktop background image and
appearance, the brightness of the backlight, and screen saver settings.

Desktop Background

The Background tab in Display Properties controls the background bitmap on
the desktop. The default bitmap is “abclocknight’.

Background | Appearance I Backlight I ScreenSaver I Advanced |

Image: | abclockright v

|:| Tile image on background

You can select another image from the pull-down menu or browse the system
for a bitmap image. Some custom images are in the \Windows folder.

Desktop Appearance

The Appearance tab in Display Properties controls the visual style and colors of
the desktop and other window elements.

Background | Appearance |Elacklight IScreenSaver IAdvanced |

Schemne:
Normal Disabled EEEscHl (||01] 2 BB Night =T
TE

wWindow Text

Dialog Box Text

-

|:| ’ Save ”Delete ” Apply ]

Item:

Two custom schemes and images provide for day or night viewing. When you
change schemes, remember to change the image on the background tab.

Scheme Desktop Color Background Logo

AB Day Blue ablclockday

AB Night Black abclocknight
Backlight Intensity

The Backlight tab in Display Properties lets you set the brightness level of the
display between 1...100%. At 1%, the display is minimally visible.

Display Properties @] E]
[Eackgmund IAppearance | Backlight IScreenSaver IAdvanced |
Brighthess

oim 100 % Eright;
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Screen Saver

The screen saver extends the life of the display. When the terminal is idle for a
continuous period, the screen saver dims the backlight and displays a moving
image. When deactivated, the display brightness returns to its normal level.

Display Properties

[Backgmund IAppearamce I Backlight | ScreenSaver | Advanced

Start screen saver after IlU minutes + | of continuous idle time.

Dimmer Image List

Dim 10 % Bright [0t

The Screen Saver tab in Display Properties lets you perform these actions:

¢ Change the idle timeout for the screen saver. The default is 10 minutes.

When the screen saver activates, the dimmer controls the backlight
intensity. You set the brightness of the dimmer in range 0...100%. The
default intensity is 10%. At 0%, the backlight is minimally visible.

e Browse the system for another screen saver bitmap. The default screen
saver is SSFloat.bmp. Click Add or Remove to change screen saver
bitmap. The system recognizes bitmaps in the \Windows folder. Only

one bitmap is supported.

e Disable the screen saver by clearing the ‘Start screen saver after’

checkbox.

Cursor

The Advanced tab in Display Properties lets you enable or disable the visible
cursor that you see on the display. The cursor is visible by default.

[Eackground IAppearance IBacinght IScreenSaver | Advanced |

7
nabled
I=] Rotation (Requires Reset)

0 degrees
90 degrees

270 degrees

Screen Rotation

The Advanced tab in Display Properties lets you rotate the screen on the

terminal. The default is 0°.

Display Properties E]

[Background I Appearance IBack\ight IScreenSaver | Advanced I

T
habled
[=| Rotation (Requires Reset)

0 degress
90 degrees
270 degrees
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After you change the screen rotation, you
have to calibrate the touch screen.

1. Plug in a USB mouse to the terminal.
2. Restart the terminal.

3.To calibrate the touch screen, use the
mouse.

4, See (alibrate the Touch Screen on
page 65 for calibration details.
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Hardware Monitor The Hardware Monitor provides status and troubleshooting information for
the terminal. You can view running processes, system event log, battery
voltages, current temperature, CPU load, and memory load.

Processes

The Processes tab in the Hardware Monitor shows all processes running on the
terminal and memory usage of each process.

PanelView Hard.wa.re Monitor:

SystemEventLog | Monitors | About
Pr: H: Pr 1d Thrl|B Addri|HeapSize |TotalMem Commi‘tte-|lleseruedl &
b |mEXE 00400002 ¥4 B0223000 3238704 0 0 o

] udevice exe 01080002 ¥ 00010000 18560 2073280 1689840 573440
] udevice exe 0ss0008, 4 00010000 2624 1818624 1634304 184320
I udevice exe 02040002 1 00010000 4928 1618624 1634304 184320
] udevice exe 03360006 1 00010000 1538 1818624 1630208 183416
| wisportm exe 03500006 4 00010000 12160 2211840 1851392 360448
] servicesd exe 03F40006 45 00010000 3553040 9653368 5791744 366EG24
7] udevice exe oFsoooz 4 00010000 2560 1953782 1648582 307200
il explorer exe 074a0002 6 00010000 458230 2703360 2007040 696320
] fselect exe O7B 0004 4 00010000 2043 1822720 1634304 185416
] RELinxhG exe OBSFOOOE 19 000MO000 1522336 5156564 3436544 1720320
I FsvocHost exe O7BDO0CE 13 00010000 108832 2703472 1908736 584736
] control exe O7CCO084 1 00010000 22580 1822720 1675264 147456
=5 [=LVISE it rdooitor OEA40SAE 0004 Q0NN TTEEN EQOEIESE  QQoaT0q Qq 0. &
Memory load 3704852480,/413700096 [2%]

System Event Log

The System Event Log in the Hardware Monitor shows warnings, errors, and
events that the terminal logs.

PanelView Hardware Monitor

Processes | Systemeventiog | Moniwrs | about
[ Export Log ][ Clear Log ][ Details ]
Type |Date |Time |Categnry |Msgld Message |:
Error 4/9/2014 | Z15:33PM Mone 65537 Backlight Temperature(id=2) at 55 C,
| Error 4/9/2014  |31333PM Mone 65537 Backlight Temperature(ic=2) at 55 C,
| Error 4/9/2014 | 25533PM  MNone 65537 Backlight Temperature(id=2) at 56 C,
| Information |4/9/2014 | 254:49P0M  PYVP 16777218 | SYSMON: System boot. Reason: Softwan—
7Informat|on 4/9/2014 | 25432 P Mone 65537 FPGAPWUPDATE: Successtully updated
| |nformation |4/2014 |25431PM None 65533 Microsoft (R) Windows CE (R) £.00.0000
_Infnrmatinn 4/9/2014 | 25431 PM None 65540 The Event log service was started
7Informat|on 4/9/2014 25241 PM PP AB777218 | SYSMON: System boot. Reason: Softwar
| |nformation |4/2014 |25223PM None 65537 FPGAFWUPDATE. Successiuly updated
] Information .4194’201 4 25222PM .NEHE 65539 Microsoft (R) Windows CE (R) 6.00.0000
7Informat|on 4/9/2014 (25222 P Mone 55540 The Event log service was started.
TEerr 4/3/2014  10:27:59 AM None 65537 Backliaht Temneraturelid=21 at 55 C.‘ . j
Cpu load 22%

The log provides a date and time stamp of each event and text that describes the
event. The maximum size of the log is 1 MB, approximately 4,000 records. If
the log exceeds 1 MB, the oldest 512K of information is removed. You can
perform the following operations on the log file:

e Press Export Log to export the log file to a CSV file (*.csv) in the
\Windows folder. The default file name is SystemLog.csv.

e To clear all events from the log, press Clear Log.

e To view more details on a selected event, press Details.

92 Rockwell Automation Publication 2711P-UMO007G-EN-P - August 2021



Chapter 4

Monitors

The Monitors tab in the Hardware Monitor provides continuous voltage,
temperature, and load information for the terminal.

PanelView Hardware Monito

| Processes | SystemBventlog M

Battery Voltage -

3.2 o [— |

CPU Temperature

2 41°C = m]

Logic Board Temperature

3 43°C

Display Temperature

4 29°C =

CPU Load

5 15% —

Memory Load

B 9% —1

BinFS thrashing

T 0% 1 ]
Cou load 15%

Battery Voltage

The Monitors tab gives a visual status and voltage reading of the battery for the
real-time clock. The battery voltage is read at power-up.

Table 22 - Battery Conditions

Condition Battery

Depleted Less than 2.0V indicates a dead battery or no power.
Low 20...2.74V

Normal 2.75V or higher

An event is logged to the system event log for a low or depleted battery.
Temperatures

The Monitors tab gives a visual status and reading of the current CPU, logic
board, and display temperature. The temperature updates every ten minutes.

Table 23 - Temperature Conditions

Condition Temperature

Low -

Normal 25...94°C(77...201°F)
High 95 °C(203 °F) and higher

An event is logged to the system event log for a failed temperature sensor.

IMPORTANT A high temperature condition causes an automatic restart attempt. Restart
attempts continue indefinitely until the system is cool enough to resume
normal operation. High temperature conditions are logged to the system
event log.
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Logo Manager @ Use the Logo Manager to change the logo that appears on the splash screen at
startup and the default screen saver image. The default splash-screen image is

1082  the Allen-Bradley logo (ablogo.bmp).

Manager

The logo can be a .bmp, .jpg, .gif, or .png image. A 90 x 90 pixel, 16-bit color

image provides the best results.

Before applying the new logo, you can do the following:
e Preview the logo on the splash screen.

¢ Resize image to fit the fixed area of the splash screen.
To apply a new logo the splash screen and the screen saver, follow these steps.

1. Double-click Logo Manager in the control panel.

The Logo Manager opens with the current logo.

PYPlus Logo Manager, E] E]
Stretch/shrink image to fit
Load Apply [] e Exit
[ ]Preview entire screen

JANE’

QuallTY

2. Click Load.
Open IE' IE ‘@'
4] O]

®

Marne: Inew logo big pe: [EMP files )

3. Select the location of the new image you want to load:

e A folder on the terminal.
e Storage Card2 - SD card
e USB Storage — USB drive

4. Select the image file that you want to load.

5. Verify that the file type is correct.
6. Click OK.
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The new logo appears in the Logo Manager dialog box.
PYPlus Logo Manager, E] E]

Stretch/shrink image to fit
Load Apply n ? Exit
[ ]Preview entire screen

PYPlus Logo Manager,

ation Inc

7. Check ‘Preview entire screen’ to view the logo on the splash screen.

If the logo is truncated or too small, check ‘Stretch/shrink image to fit’
to resize the logo to fit the area.

8. Ifsatistied with the preview, click Apply.

A dialog box confirms that the splash screen was updated. The default
screen saver, ssfloat.bmp, is updated with the new image.

9. To close the Logo Manager, click OK, then click Exit.
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User Accounts

96

User Accounts let you configure NT LAN manager (NTLM) user accounts to
authenticate client connections when using the FTP, web, and file servers. A
user account consists of a user name and a password.

TIP  NTLM s the security protocol that provides authentication, integrity, and
confidentiality to users on Windows operating systems. NTLM is still
included to support Windows 2000, 2002, and 2003 server systems.

Follow these steps to add a user account.

w 1. Double-click User Accounts in the control panel.

o

Accaunts WTLM user

User name

[

[ Add user ] [ Remove user ]

2. Click in the user name field and type a name.

3. To clear the field and type a password, click in the Password field.
Asterisks display as you type the password.

4. Reenter the password in the Confirm pwd field.

User. Account: Manager: E] E]

NTLM user

User name  |kasmith
Passwiord ok ok ok ok ok

Confirrm praed |+ #4444

@d user | [ Remove user

5. Click Add User.

LA

Add user account

Succesfully added nesw user account kasmith'

6. Click OK to acknowledge the new user account.

The new user name is added to the list.

User. Account: Manager. !
MTLM user

User name

H

[ Adduser | [ Remaove user |

7. Repeat steps 1 through 6 to add additional user accounts.
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8. When done, click X to close the dialog box.

To remove a user account, follow these steps.

User, Account: Manager.

MTLM user

User name
z

[ Adduser | { Remaoveuser D

Password

1. Select a name from the user name list.

2. Click Remove User.

Remoye user, account.

@ Are you sure you want to remove user ‘hpconrad'?

3. To confirm the removal of the selected user account, click Yes.

The user account list is permanently deleted from the list.

4. To close the User Account Manager, click X.

TIP  Users who are entered in authentication lists of FTP, web, or file server
configurations are removed when user accounts are deleted.
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Services : g The Services application shows servers the PanelView Plus 7 Standard terminal

supports. You can enable (start) or disable (stop) each server.

Services s
Services

Web Server

DONE

The buttons are color-coded:

e Green indicates that the server is running and automatically started at
system startup.

¢ Red indicates that the server is not running.

¢ Gray indicates that the server is not available on the terminal.

To enable or disable a server, press the corresponding button and the color
changes accordingly.

Network Server 9 The Network Server Configuration application configures settings for VNC,
i i ¥  FTP web, Kepware, and file server activities on an Ethernet network.
Configuration , web, Kepware,

Server
Config

VNC Server Configuration

The terminal provides two VNC client viewers:

e Vncviewer.exe is in the /Windows folder on the terminal desktop. You
can deploy this viewer to a personal computer to connect to, view, and
control a PanelView Plus 7 terminal. See these sections for details:

- VNC Connection Requiring a Password for View-only Operations

on page 29

- VNC Connection with Separate Passwords for View and Control
Operations on page 100

e Another viewer on the terminal lets you establish a VNC connection to
another PanelView Plus 7 terminal. To access this viewer, click
Start>Programs>VNC Viewer. See these sections for details:

— Establish a VINC Connection Between a Local Terminal and a
Remote Terminal on page 102

— Close a VNC Connection to a Remote Terminal on page 104

— Make a New VNC Connection to a Remote Terminal on page 104

— Transfer Files Between a Local and a Remote Terminal on page 105
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The VNC Server tab in the Network Server Configuration dialog box
configures settings for a client device to view or control the terminal over a

VNC connection.

Netwaork Server, Configuration

YWigny Only (ho remote control)
Ty

[T Enable security

2] wiewe-arly password

| |Security settings

TIP  Click OK in the title bar of the dialog box to apply new settings. You are

asked if you want to restart the service immediately.

Table 24 - UNC Server Parameters

VNC Parameter

Description

Default

General

View Only (no remote
control)

Check this option to let users view terminal displays over a VNC connection.
If you uncheck View Only, you can control and view terminal displays over a VNC connection.
If security is disabled, you are not required to enter a password when connecting to the terminal.

Enabled for view only

Security

Enable security

Check this option to require password protection for VNC connections to the terminal. When checked, you must enter a
valid password before viewing or controlling terminal displays.

If you enable security, you must supply a password for one of these parameters:

« Password - for control and view operations

« View-only password - for view only operations

Disabled (unchecked)

Password

Specifies a password that you must enter when establishing a VNC connection to control terminal displays. Select the
box, then type a password in the field at the bottom of the dialog box. The password is a maximum of seven characters.
Password protection is required to control terminal displays if:

« View Only is unchecked (allows control access)

« Security is enabled

No password

View-only password

Specifies a password that you must enter when establishing a VNC connection to view terminal displays. Select the box,
then type a password in the field at the bottom of the dialog box. The password is a maximum of seven characters.
TIP: If you uncheck the View Only parameter, you have control and view access to the terminal. With control access
enabled, you can restrict one or more users to view-only access by providing a View-only password.

View-only password protection is required to view terminal displays if security is enabled:

« View Only is checked or unchecked

« Security is enabled

No password

VNC Connection Requiring a Password for View-only Operations

The default VNC configuration enables view-only access to the terminal
without requiring a password. This configuration requires the VNC viewer

that you copy from your terminal to a computer.

TIP  Copy vncviewer.exe, in the /Windows folder on the terminal, to your

computer and install the TightVNC software.

To configure a VNC connection that requires a password to view terminal

displays, follow these steps.
Q 1. From the control panel, click Server Config.
Server

Caonfig
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Network Server, Configuration

WNC Server | wee Server | FTP Server | File Server | Kepware Server |

=] Se

| Enable security

[ Paseword
=] wiew-only password

R |Bets WRC viesw-only password (7 characters max)
2. On the VNC Server tab, check the following:

e View only (no remote control)

e Enable security

3. Select View-only password, then enter a seven-character password in the

field that opens.

4. Click OK, then restart the server when prompted to apply new settings.

Follow these steps to launch a VNC connection to view terminal operations.

1. On your computer, choose Start>Programs>TightVNC>TightVNC

Viewer.

New TightVNC Connection

Tight¥NC Server{( 197.168.124.96 v < Conneck P

Connection profile

O Love-bandwidth connection _

@ Defaulk conneckion options

o () High-speed network

2. Enter the IP address of your terminal and click Connect.
TIP  Click the network connection icon in the system tray to view the IP

S address of the terminal.

Standard ¥NC Authenticat x|

WMC Host: |192.168.124.96
mf_ Username:l

e
XN?(_:_ F'asswor
q ok p Cancel |

3. Enter the View-only password that is defined on the terminal and click

OK.

The PanelView VNC Server opens the current view of the terminal on
your desktop. You can view but not control terminal operations.

4, When finished, close the PanelView VNC Server.

VNC Connection with Separate Passwords for View and Control Operations

You can configure the VNC server to require separate passwords for view-only
and control operations. This example uses the VNC viewer that is deployed to
a computer to connect to the terminal.

TIP  Copy vncviewer.exe, in the /Windows folder on the terminal, to your
computer and install the TightVNC software.
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Follow these steps to configure the VINC server to require a separate password
for view-only and control operations.

1. From the control panel, click Server Config.

i L
9 Netwark Seryer Configuration

Server WNC Server | WEB Server | FTR Server | File Server | Kepware Server |

Config

=] wigw-orly password

—> |*****”‘ |Sets YNC password (WARNING: 7 characters max)

2. On the VNC Server tab, do the following:
e Clear View only (no remote control).

o Check Enable security.
3. Select Password, then enter a password for control privileges.

Passwords are a maximum of seven characters.

Network Seryer. Caonfiguration

WNC Server | WEE Sarver | FTP Server | File Sarver | Kepware Server |

=] General
|:| Wigw Only (no remote contraol)
=] Security

Enable security
El

—-Pl*****‘* |Sets WHC view-only password (7 characters max)

4. Select View-only password, then enter a password for view-only
privileges.

5. Click OK, then restart the service when prompted to apply new settings.

Follow these steps to launch a VNC connection to enable control of the
terminal.
TIP  Tolaunch aVNC connection on your computer that requires a
password for view-only operations, refer to YNC Connection
Requiring a Password for View-only Operations on page 99 and
follow steps 1 through 4.

1. On your computer, choose Start>Programs>TightVNC>TightVNC

Viewer.
x
TightWMC Server: I j | Connest I
m. Connection profile*C Wlfare.. )
VNC " Low-bandwidth connection
Lu——f ' Default connection options Listening mode |

 Highrspeed network Close |

Configuration... |
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2. Click Options.

Connection Options

r— Format and Encodings
Usze encoding:

I Tight 2 l
[T Use Sbit color

[ Custom compression level;

fagh ———/F—— best

levell &
¥ &llow JPEG compression:

pogp ——————— j—— hest

quality: &
[+ &llow CopyRect encoding

~ Display
Scale by: I‘IDD vl &
[T Full-zeresn mode

™ Deicorify on remote Bell event

 Mouse
[V Ernulate 3 buttons [with 2-button click)

™ Swap mouse buttons 2 and 3

r~ Mouse Cursor
& Track remate cursor locally
7 Let remote server deal with mouse cursor

€ Dor't show remate cursor

rRestigtions——————— [ Local Cursor Shape————————————————
C T Wiew only [inputs ignored & Dot cursor
" Disable clipboard transfer " Small dot cursor

© Momal arrow

V¥ Request shared session " Mo local cursar

< ()3 b Cancel |

Clear View only (inputs ignored).
4, Click OK.
Tight¥NC Serverw C  connect )

Connection profile

O Low-bandwidth connection

@ Defaulk connection options

T () High-speed network

5. Enter the IP address of your terminal and click Connect.

I TIP  Click the network connection icon in the system tray to view the IP
address of the terminal.

The Standard VNC Authentication dialog box opens.

standard ¥NC Authenticab |

WNC Host: |192.168.124.96
Uszer name: I

gt
VN_(_:_ Password
( ()8 I ) Cancel |

6. Enter the control password that is defined on the terminal and click OK.

7. On your computer, perform some actions to verify that you have control
of the terminal.

8. When finished, close the PanelView VNC Server.

Establish a VNC Connection Between a Local Terminal and a Remote Terminal

Follow these steps to establish a VNC connection from a local terminal to a
remote terminal.
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1. Access the Windows desktop of the local terminal.

2. On the local terminal (viewer) desktop, choose Start>Programs>VNC
Viewer.

New Tight¥NC Connection

Tight¥MC Server( | 192,168, 124,96

£

‘ Conneck )
Connechion profile

O Low-bandwidth connection

@ Default connection options

Configuration... () High-speed network

3. Enter the IP address of the remote terminal that you want to connect to
and click Connect.
TIP  Select an IP address from the pull-down menu, or enter an IP
address by using a USB keyboard or soft input panel (see Soft Input

Panels on page 84).

A Status message displays while the connection is being made. The
messages can cycle as the status changes.

C' Connection ‘_S

1

Tight

Skatus: Interaction capability list received.

The message ‘Please wait - initial screen loading’ can also display after
the connection has been made and while the desktop of the remote
terminal is loading,

After the screen has loaded, the desktop of the remote terminal displays
on the local terminal. You can now access the features and functions of
the remote terminal.

" B PunelView YN Server [zoorm 100%] =]
®B (& Si& W, B3| |ov |ohijow| el | W
[options |1 [1) & o0 glllov i i B

Automation

»
|45t | r [EwBszam 4]

The white dotted line indicates the remote terminal and is only for reference (the dotted
line does not actually appear on the local terminal).

Note the two Start buttons: circled in white is the remote terminal; circled in black is the
local terminal.
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Close a VNC Connection to a Remote Terminal

Follow these steps to close a VNC connection between a local terminal and a
remote terminal.

1. Establish a VNC connection from a local terminal to a remote terminal

(see page 102).
2. On the local terminal, right-click PanelView VNC Server.
' TIP  Touch the screen for 1 second or longer for a right-click.

Dioc

= .
& st | Remote Terminal

<

o | .
G stat Jranetview vnic server Rt S <—— Local Terminal

4, Click Close.

The VNC connection to the remote terminal is closed.

TIP  Totoggle between the remote terminal (server) and local terminal
(viewer) views, click PanelView VNC Server.

I_'F Make a New VNC Connection to a Remote Terminal

To make a new VNC connection to another terminal, follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal
(see page 102).

2. Click the New connection icon in the menu bar.

New Tight¥NC Connection

Tight¥MC Server: ((192.168.124.96 v ( Connect b

Conneckion profile

O Low-bandwidth connection

@ Default connection options

Configuration... { ) High-speed netwark

3. Enter the IP address of the new remote terminal that you want to
connect to and click Connect.
TIP  Select an IP address from the pull-down menu, or enter an IP
address by using a USB keyboard or soft input panel on the local
terminal (viewer) (see Soft Input Panels on page 84).

The local terminal creates a VNC connection to the new terminal.
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EL Transfer Files Between a Local and a Remote Terminal
Use the TightVNC File Transfer dialog box to perform these tasks:

Transfer files and folders between connected terminals

e Rename a selected file or folder
o Create a folder

o Delete a selected file or folder

To transfer files between the local terminal and the remote terminal, follow
these steps.

1. Establish a VNC connection from a local terminal to a remote terminal
(see page 102).

2. Click the Transfer files icon in the menu bar.

3. Select the folder or files that you want to transfer.
4. Click the upload (>>)or download (< <)files icon.
5. Click Yes.

6. To view the change (if needed), click Refresh.

To move up one directory level, Indicates the current

double-click the arrow. directory level.

Tight¥NC File Transfer,

Local Computer (Miewer) Remake Computer (Server)
|My Documents / I}
Filename / l Size: I Modification kime I Filename | Size I Maodification time I
59570 4—J <Falder» B metwork <Falder>
CIFants <Falder> CIvrs <Falder >
I'-1:; Falde <Folder = [ windaws <Folder =
CMy Folder 2 <Folder > [ emp «Folder >
(B desktop.ini 698 9/7/2006 1:00:00 AM I Program Files <Folder >
CAMy Documents «Folder >
= [ Application Data «Falder =
) Recyded «Folder >
Upload selected files from the local terminal e ] L2 ool Pane 285] “oliBiZ0L Iz S
. Frlnter‘swap 4.00KB 9/25/2014 6:19:06, .,
to the remote terminal.

™~ Download selected files from the remote
terminal to the local terminal.

I Rename I l Tilkdir l [ Remove ] [ Refresh Rename ] [ Mkdlir ] [ Remove ] [ Refresh ] |
| v
Cancel
Message field that records Rename = opens a dialog box where you can rename the selected file or folder.
actions and errors for the Mkdir = lets you create a folder.
current VNC session. Remove = deletes the selected file or folder.

Refresh = updates the view.
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Web Server Configuration

The web server tab in the Network Server Configuration application
configures settings that are used for HT'TP web activities. These settings are
standard Microsoft Windows CE parameters.

Network Seryer Configuration

VMG Server | WEB Server | FTP Sarver | File Server | Kepware Server |

| mm File Miraetoe:

~
Admin Users
|| Basic Authentication
=] Default weh Page
|| Allow directory browsing
=] Max Connections 3

TIP  Toapply new settings, click OK in the title bar of the dialog box. You are

asked if you want to restart the service immediately.

Table 25 - Web server Parameters

Parameter Description Default
Admin Users Specifies a list of users who are allowed to administer web | ADMIN
activities.
When selected, enter a list of user names, which are
separated by semicolons, in the field that opens at the
bottom of the dialog box.
Basic Authentication To require a user name and password to access theweb | Disabled (unchecked)
server, check this option.
Default Web Page Specifies default web pages that you can access. default.htm; index.htm
Allow Directory Browsing | To browse directories on a web server, check this option. | Disabled (unchecked)
Max Connections Specifies the maximum number of incoming web 256
connections.
Log File Directory Specifies the path where the log file is stored. This file logs | \windows\www
web activity.
Max Log Size Specifies the maximum size of the log file that is stored in | 32768 bytes
the log file directory.
Anew log file is created, when the current log file reaches
its maximum size.
NTLM Authentication To require a valid user name and password to access the | Enabled (checked)

web server, check this option.
If NTLM Authentication is enabled, you must enter a valid
user name in the Admin Users field.

NTLM user accounts are defined in the User Account
Manager of the control panel.
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FTP Server Configuration

The FTP Server tab in Network Server Configuration defines settings that are
used to exchange files over a network. These settings are standard Microsoft

Windows CE parameters.

Netwaork Server, Configuration

The default FTP configuration lets you establish an FTP connection to the
terminal, log in anonymously, and download files from the FTP default

directory (\Temp).

TIP  To apply new settings, click OK in the title bar of the dialog box. You are

asked if you want to restart the service immediately.

Table 26 - FTP Server Parameters

FTP Parameters Description Default
General
Default Directory Specifies a storage location on your terminal where you can transfer files. \Temp\
This location is the directory that users come to when they first connect to the FTP server.
Idle Timeout Specifies an idle period after which inactive control connections are closed during a data transfer. An FTP session requires | 300 seconds
one control connection, plus one data connection, during file transfers. (5 minutes)
Without a timeout, the FTP server process can be left pending indefinitely if the corresponding client crashes without
closing the control connection.
Debug Output Channels Specifies the number of debug output channels. 2
Debug Output Mask Specifies the port number of the output mask that is used for debugging. 23
Base Directory Specifies the path where the FTP log file and other support files are stored. \Windows
Log Size Specifies the maximum size of the file that logs FTP activities. The log file is stored in the base directory. 4096 bytes
Anew log file is created, when the current log file reaches its maximum size.
Security Parameters
Use Authentication To require a valid NTLM user name and password to access the FTP server, check this option. Enabled (checked)
If authentication is enabled, you must enter one or more valid user names in the User List field.
NTLM user accounts are defined in the User Account Manager of the control panel.
Allow Anonymous Logins To let anyone connect to the FTP server, check this option. Anonymous logins do not require a user name and password. | Enabled (checked)
Allow Anonymous Uploads | To let users logged in anonymously to upload (or write) files to the FTP server (or default directory), check this option. | Disabled (unchecked)
If unchecked, users logged in anonymously can download (or copy) files from the server.
Allow Anonymous VRoots | To let users logged in anonymously to access virtual roots, check this option. Disabled (unchecked)
User List Specifies the NTLM users that can access the FTP server and exchange files to or from the default directory. None

When selected, you can enter a list of NTLM user names, which are separated by semicolons, in the field that opens at
the bottom of the dialog box. User names and passwords are defined in the User Account Manager of the control panel.
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FTP Anonymous Login and Upload

Use the default FTP security options to log in anonymously to the terminal
and copy files between your computer and the default FTP folder on the
terminal.

Netwaork Server, Configuration

File Server | Kepware Server

| |AIIOW Anoryrmnous Uploads

TIP  If Allow Anonymous Uploads is unchecked, you can copy files from the
default FTP folder on the terminal but not to the folder.

To establish an FTP connection to the terminal by using anonymous logins
and file transfers to and from the FTP folder, follow these steps.
1. On your computer, open the web browser or any folder.

2. Determine the IP address of your terminal by clicking the Network
- Connection icon in the system tray.

3. Type the terminal IP address in the address field.

EXAMPLE  Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.
For example, ftp://192.168.124.96

A connection is established to the \Temp folder, the default FTP
directory on the terminal. The terminal shows two files.

W® fip:// 152.185.124.96 N =
p— =10l
‘G\ )7 [£ - The Intemet - 182 158 124 95 - &[5t g
Fle Edt Vew Toos Hep
Orgarize ~ 6 - @
T Faverites - | Impor tant Notes.docx
Bl Desktop pe| Test.bmp
[ ponnloads
%] Recent Places
B Desktop

If you launch the FTP connection from your web browser, this view can appear.

G -
G 238

Favortes | 121 “Classc” Trart Midous see... |, | tome - TechCome Sruns.., (L] Soppested Saes = A Remate Acoms Logan
TP 1ot s 140484124 88 | | Bio D L am e Paper Saltye Todke e
=

FTP root at 192.168.124.96

Tao view this FTP site in Windows Explorer, click Page. and then click Open FTP Site in Windows Explorer.

12,66
3,39

ant Motes.docx

To sce the folder view, choose Open FTP site in Windows Explorer from the
Page pull-down menu.
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4. 'Transfer files between your computer and the FTP folder on the
terminal:

e Dragor copy afile from the FTP folder to your computer.
e Dragor copy afile to the FTP folder from your computer.

FTP Connection Requiring User Authentication
You can require a user name and password before establishing an FTP

connection. On the FTP Server tab, check Use Authentication. Select User
List and enter a valid user name in the field that opens at the bottom of tab.

Network Seryver Configuration

=| S SEa
Use Authentication
Alow ArreroUs Logins

|| allow snorymous Uploads

(kasmlth;operaﬂ&rLM user harne, exarmple: Userl;User2;User3

TIP  User names and passwords are configured in the User Accounts
application of the control panel. Refer to User Accounts on page 96 for
details.

To establish an FTP connection to the terminal by entering a valid user name
and password, follow these steps.
1. On your computer, open any folder or the browser.

2. Determine the IP address of your terminal by clicking the Network
=" Connection icon in the system tray.

3. Type the terminal IP address in the Windows Explorer address field.

EXAMPLE  Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.
For example, ftp://192.168.124.96

4. Click OK if the FTP Folder Error dialog box appears.

5. From the File menu, choose Login As.
x

’? Tolog on to this FTP server, type a user name and password

192.168.124.96
User name: [ kamenty |

Password: | eeses

FTP does not encrypt ar encade passwords or data before sending them to the
server, To protect the security of your passwords and data, use WebDAV instead.

™ Log on anonymously I~ save password,

Cao D o

TIP  The user name must be in the User List of the FTP configuration
and previously configure as a valid account in the User Accounts
application.
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6. Type avalid user name and password, then click Log On.

The default FTP directory on the terminal opens. You can transfer files
to or from this folder.

MEECETEEEE— =lolx|

P\ [ - e et~ 153 168 12496 v B[Sl g

He Edt Wew Tosh el

g S
+ Favores e - 5
3;:49'3'51"& LL4) ]i-—wm;mmm Em:w

.
File Server

The File Server tab in Network Server Configuration has settings that allow
shared access to files, printers, serial ports, and miscellaneous communication
between computers on a network. These settings are standard Microsoft
Windows CE parameters.

Netwaork Server, Configuration

[Z] Adapter List

=] Max Prirter Swap Size
=] Security Cptions

[ ] use Authentication

User List

| |
TIP  Toapply the new settings, click OK in the title bar of the dialog box. You are
asked if you want to restart the service immediately.

Table 27 - File Server Configuration

Parameter Description Default

General

Adapter List Provides a list of valid adapters. * (all adapters)

Max Printer Swap Size Specifies the maximum size of the printer swap file. 4096 bytes

Security Options

Use Authentication To require a valid NTLM user name and password to access | Disabled (unchecked)

the file server, check this option.

If authentication is enabled, you must enter one or more
valid user names in the User List field.

NTLM user accounts are defined in the User Account
Manager of the control panel.

User List Specifies a list of valid NTLM users who are allowed to None
access the file server.

When selected, you can enter a list of NTLM user names,
which are separated by semicolons, in the field that opens
at the bottom of the dialog box. User names and
passwords are defined in the User Account Manager of the
control panel.
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System Information

KEPServer Configuration

The Kepware Server tab in Network Server Configuration lets you select
Kepware communication drivers for connected devices.

TIP  Fora complete list of KepWare drivers, go to

http://www.rockwellautomation.com/knowledgebase and search the
Knowledgebase for keywords ‘KepWare Drivers for PanelView Plus’

Netwaork Server, Configuration

YNC Server | WEB Server | FTP Server | File Server | Kepware Server |

=] Kepware Communication Drivers (requires reset) S
Allen-Bradley Bulletin 900
Allen-Bradley Bulletin 1609
AutomationDirect DirectMNet
AutomationDirect EBC
AutomationDirect ECOM
PAmot I TD

IMPORTANT  Toapply new settings, click OK in the title bar. You are asked if you want to
restart the service immediately. You must also reset your terminal.

The System Information application provides tabs to view and set system-wide
properties for your terminal.

General Information

The General tab of System Information shows the current version of the
Windows CE operating system, the processor type, speed, and available
memory.

System Information @] @
IStartup Options I Device MName I Copyrights I

System: Computer:

Microsoft® WindowsE CE Processor Type: [WIA Technologies, In
Wersion 6,00 Speed: [1000 MHz

R& OS Firmweare Wersion: 02,07

© 2006 Microsoft Corp. Al rights Mermnory: 440136 KB RAM

reserved. This computer program is
protected by U.S. and international
copyright laws.

Registered to:

Startup Options

The Startup Options tab of System Information lets you set these start-up
options:

e Show or hide the battery warning

e Launch the terminal as open or closed

e Disable or enable Safe mode
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o Configure the Ethernet ports for DLR, star, or linear topology

o Show or hide system watchdog errors

System Information

General | Startup Options |Device Marme ICDpyrights |

[oK] (x

Warrings
(8] Always show at startup (continue with startup)
() Always show at startup (halt startup)
. MNever show at startup
=] Shell
(Open systern) Run Windows Desktop Explorer at startup
(nsad swsternt Run FartoeeTalke Vieswe ME Statinn at ctarton

Battery Warnings

If the battery is low, missing, or depleted, a
warning appears each time that the terminal
starts up.

TIP - The terminal can operate
without a battery if the accuracy
of the date and time is not
critical.

« When replacing the battery, you
can verify the accuracy of the
system date and time from the
desktop control panel or the
terminal settings in FactoryTalk

i N = 4
Battery Low/Depleted: Replace battery and verify

time/ date of system clock. Otherwise, time/date
stamped data may be inaccurate!

View ME Station.

You have three options for handling the battery.

Battery Warning Startup Options Description

Always show at startup (continue with startup) Shows the battery warning at startup with FactoryTalk View

default.

ME Station software that runs behind it. This option is the

Always show at startup (halt startup)

Shows the battery warning at startup but halts the startup or
boot process until you press OK.

Never show at startup

Hides the battery warning at startup.

Startup Options

To launch an open or closed desktop at startup and to set the visual appearance

of button controls, use the Shell options.

System Information m B
General | Startup Options | Device Mame | Copyrights |

=] shell ~
Type
8 (Open system) Run Windows Desktop Explorer at startup
{Closed systemn) Run FactoryTalk view ME Station at startup
Liser Interface Button Contraols
Windows ¥P Style
Windows 95 Style

=I| Ront
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Shell Startup Options Description

Type Launches the terminal as an open or closed system at startup:

(Open system) — launches the Windows CE desktop on startup.
(Closed system) (default) — launches FactoryTalk View ME Station
Configuration mode on startup.

You can also allow or restrict desktop access within FactoryTalk View ME

Station Configuration mode by pressing Terminal Settings>Desktop
Access Setup. Refer to Desktop Access on page 48.

User Interface Button Controls Sets the visual appearance of control buttons at startup:
+ Windows XP Style (default)
+ Windows 95 Style

Boot Option

The boot options provide a way for you to enter Safe mode at startup.

System Information @] E]

General | Startup Options IDevice Marme ICDpyrights |

=] Boot -
Safe Mode

Do not detect safe mode request at startup
() Detect safe mode request at startup

Safe Mode Options Description

Do not detect Safe mode requestat | Disables Safe mode detection during startup. This option is the default.
startup

Detect Safe mode request at startup | Displays a small white box in the lower left corner of the terminal display
during startup. To enter Safe mode, press and hold the white box. This
option lets you bypass a loaded FactoryTalk View ME application and go
directly to Configuration mode. If you do not press the white box, the
system boots up normally.

Another way to enter Safe mode is to access Maintenance mode.

See Maintenance Mode Operations on page 145.

Configure the Ethernet Ports

The ‘Network (On-board Embedded Ethernet Switch - DLR)’ provides
options to configure the onboard Ethernet switch of the terminal for the
network topology. You can also configure the Ethernet ports from the terminal
menus. See Configure the Ethernet Ports on page 58.

After changing the selections, restart the terminal for the changes to take effect.

| General ] Startup Options I'Devlce Name] Copyrights I
|I=]| Metwork (On-bioard Ermbedded Ethermet Switch - DLR) &

=] Port {Link) Configuration
§ Port 1 (Link 1) and Port 2 (Link 2) Enabled

Port 1 (Link 1) Only Enabled
Port 2 (Link 2) Only Enabled
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Port (Link) Configuration Description

Port 1 (Link 1) and Port 2 (Link 2) Enabled Enables Link 1 and Link 2 Ethernet connections for DLR
configuration.

Port 1 (Link 1) Only Enabled Enables Link 1 Ethernet connection for star or linear configuration.

Port 2 (Link 2) Only Enabled Enables Link 2 Ethernet

Watchdog Errors

You can show or hide watchdog errors at startup.

System Information

General | Startup Options |Device Mame ICDpyrights |

=] Watchdog ~
Errar Reparting
Always shiow watchdog errors at startup
() Mever shiow watchdog errors at startup

Watchdog Error Options Description

Always show watchdog errors at startup Shows the fatal watchdog error (error 02) at startup and halts
the normal boot process. This option is the default.

The system launches the maintenance window with the
watchdog error displayed. You can continue booting from this
window. Refer to Maintenance Mode Operations on page 145
for details.

The error is logged to the System Event log.

Never show watchdog errors at startup Hides the errors at startup and adds the error to the system
event log.

Advanced Diagnostics

Advanced diagnostics are for technical support use to diagnose and resolve
system errors. They are not for use in a normal production environment.

System Information m ﬂ

General | Startup Options |Device Mame ICDpyrights |

(=] Advanced Diagnostics (Warning: for tech support usage only!) ~
Watson Log Files
(8] Systern Durmp (Default - Size up to several MB)

() Mone

() Cartext Dump (Size up to 64 KE)

() Complete Dump (Size upt to 500 ME)
watchdog Functionality

Device Name

The Device Name tab of System Information identifies your terminal to other
devices on the network by providing a device name and description.

System Information

General I Startup Options | Device: Narme |C0pyrights |

1 E These settings are used to identify your Windaws CE device to

other compuiters. :
Plzase type a name (without any spaces) and a short description.

Cievice name: IF‘VP62604|

Device description: |R0ckwe|| Autormation 2711P-T10C21D85

Ly
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Touch Properties

Tauch

TIP  Device names must be unique. Duplicate names conflict and cause
network problems.

Touch Properties is accessible on devices with a touch screen. It lets you
calibrate the touch screen and set the sensitivity of touch screen taps.

(Calibration

If your device is not responding appropriately to taps, the Calibration tab lets
you recalibrate the touch screen. To recalibrate, follow the instructions in the

dialog box.
[ok] [ |

Touch Proper;

DDubIe-Taé Calibration

—— If your Windows CE device is not responding properly to your taps, you
._% may need to recalbrate your screen.
Recalibration involves tapping the center of a target. If you miss the
center, keep the stylus on the screen, slide it over the target's center,
and then lift the stylus. To start, tap Recalibrate.

Double-Tap

The Double-Tap tab lets you set and test the double-tap sensitivity of the touch
screen taps.

Touch Properties @] E]
Double-Tap | Calibration

Double-tap this grid to set the double-tap sensitivity for both
the speed and physical distance betwesn taps.

Double-tap this icon to test your double-tap settings. If this icon
doesn't change, adjust your settings using the grid above.
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PDF Reader The PDF reader provides typical view and search functions. You can run this

reader from the Windows desktop or a command prompt.

AN

When viewing a PDF document, you can initiate functions from the menu or
toolbar. Bookmarks created in the original PDF appear under bookmarks.

Figure 7 - PDF Reader Workspace

Page Search
Navigation Rotate
Open Zoom |

|

IMEH‘UIIMI<I>IMI Bl 2l=l=] =]
File

Zoom
Wiews
Page
Find
About..,
Exit 2 G . sl Diien . Mw'—\ll GRCiies | Do 2 e 8.5 0 g

Bookmarks

Page Navigation

Prev/Next
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Magnified view of page with minimap. You can
touch the gray areas on the minimap to view
another area of page at the same zoom level.
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s B gieion wamperares o ehan 135C- {273 ).
e T3

s B o snprarinss b e 200C. (352 ).

Current Page

Podomell futormaion Publa 00 771 1P INIZSAEM P Sepaarrber 2010

Some viewing functions can be initiated on touch screen terminals with a
touch or drag.

Table 28 - Touch Screen Operations

To Do This Indicator

Zoom In or Out Tap the screen once to zoom in. A A
. <«@> <O

Tap the screen again to zoom out. vV

If Menu>View>Minimap is chosen, a miniview of the page appears in lower right of
workspace. You can tap the gray areas to change view.

Navigate pages « Drag your stylus or finger to the right or left to view next and previous pages. A}
< >
An indicator shows the direction your are dragging. v
A box shows the current page/total page count. 3/32
- Toactivate the page navigation bar on the right, drag up or down the screen. See page
Move slide bar up or down to navigate pages. navigation barin
Figure 7.
Rotate Drag in a circular, clockwise or counterclockwise direction to rotate the page. P
[ ]
-
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Table 29 - Command Prompt Parameters

Command Prompt Parameters

You can run the PDF reader from the Windows Command Prompt when you
choose Start>Programs>Command Prompt and execute the command

parameters in Table 29.

Command Prompt Syntax

Foxitreader “file_path/file-name.pdf” parameter parameter_ value

o To separate the file path directories and file name, enclose the file
path and file name in double quotes and use forward slashes.

o To separate the parameter from the file name and optional parameter

value, use spaces.

Command Prompt Example

Foxitreader “windows/desktop/example.pdf” -p 4.

This command prompt opens example.pdf in Foxit Reader at page 4.

Parameter Parameter Function Example Description

-p Go to page Foxitreader “file_path/file.pdf”-p 2 Opens the PDF file to page 2.

Al Fit width Foxitreader “file_path/file.pdf”-zw Opens the PDF file and fits the view to the page width.

-zp Fit page Foxitreader “file.pdf"-zp Opens the PDF file and shows the full page.

-z Zoom to Foxitreader “file.pdf"-z 150 Opens the PDF file and zooms to 150%.

Multiple Enter empty spaces between Foxitreader “file_path/file.pdf"-p 2 -zw Opens the PDF file to page 2 and fits the view to the

parameters parameters and parameter values page width.

-b Go to bookmark Foxitreader “file_path/file.pdf"-b “Bookmark1” Opens the PDF file to the location specified within
Bookmark1.

-d Go to named destination Foxitreader “file_path/file.pdf”-b “Destination1” Opens the PDF file to the location specified within
Destination 1.

-g Disable the File>0pen command on Foxitreader “file_path/file.pdf”-g Opens the PDF file and dims the Menu, File>Open

the Menu and the Open folder button. command and the Open button.
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Install and Replace Components

Topic Page
Connect to USB Ports 120
Install a USB Printer 121
Insert an SD Card 123
Replace the Battery 125
Install a Protective Overlay 127

A\

ATTENTION: Prevent Electrostatic Discharge (ESD)

This equipment is sensitive to electrostatic discharge that can cause internal
damage and affect normal operation.

Follow these guidelines when you handle this equipment:

Touch a grounded object to discharge potential static.

Wear an approved grounding wriststrap.

Do not touch connectors or pins on component boards.

Do not touch circuit components inside the equipment.

Use a static-safe workstation, if available.

Store the equipment in appropriate static-safe packaging when not in use.

A\

ATTENTION: Shock Hazard

Disconnect all power before installing or replacing any components. Failure to
disconnect power can result in electrical shock or damage to the terminal.

X

At the end of its life, collect this equipment separately from any unsorted
municipal waste.

TIP

For a complete list of supported devices, go to
http://www.rockwellautomation.com/knowledgebase and search the
Knowledgebase for keywords ‘PanelView™ Plus Hardware Compatibility
List!
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Connect to USB Ports

120

Each terminal has one USB 2.0 (type A) host connection and one USB 2.0
(type B) device connection:

e The USB host connection supports removable USB drives and a USB
printer.

IMPORTANT

Refer to Considerations for Mounting on page 24 for information on

how to use the USB host ports and USB peripheral devices in
hazardous locations.

e The USB device connection SUppOIts a connection to a host computer.

IMPORTANT  The USB host and device connections are intended for temporary use. Do
not use the USB host and device connections for runtime operations.

USB Device
Connection

USB Host Connection

Icons identify the USB host connections. The USB host connection supports
0.5A at 5V DC. Connected USB devices must not exceed this power load.

Table 30 - USB Connector Pinout

USB Port Icon USB Connector | Pin | Signal Description
Host 1 V(C +5V
“:f,:: ' 2 D- Data-
Device [1:2] 3 D+ Data +
o 4 GND Ground

A\

WARNING: USB devices that are not powered by the USB port must be
within the same enclosure as the terminal. The USB devices must be
connected to a ground system common with the terminal or used with a
USB hub that provides galvanic isolation.
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Install a USB Printer

File ¥iew Tools Help

©
Add Local
Printer

Add
ROP(T...

Connect only externally powered USB hubs to the terminal that are USB 2.0
compatible. Before you attach devices to a USB hub, make sure that the power
adapter is connected and powered on.

USB Cables

Use high-speed, USB 2.0 certified cables for error-free transmissions.

The terminal supports the connection of one USB printer such as Canon,
Epson, Hewlett-Packard, and Brother. The printers support plug-and-play
installation and manual installation if a suitable driver is available. You can
connect a printer to a USB port on the terminal.

TIP  For more information on supported printers, go to
http://www.rockwellautomation.com/knowledgebase and search the
Knowledgebase for keywords ‘Printers Supported on PanelView Plus’

Printers are configured and managed from the Printers application & in the

desktop control panel. A wizard is supported for each printer type.

Table 31 - Support for Printers

Printer Type Description

Local USB You can connect a JETCET-supported printer to a USB host port.

The printer that is attached to the USB host port can be shared by a remote terminal when
configured as a network printer on the remote terminal.

Network The terminal supports a remote printer that is connected to the network via the Ethernet
port. The printer address can be its device name or IP address.

RDP /ICA Alocal printer can be made available to a Windows server application that is runningin a
remote desktop protocol (RDP) session on the terminal.

After configuring a printer, you can access it from desktop applications or from
FactoryTalk® View ME Station. Press Terminal Settings, then choose Print
Setup. Applications can also select and share printers.

Plug-and-Play Installation

Follow these steps to install a plug-and-play printer from the Windows
desktop. For manual printer installation, refer to Manual Printer Installation

on page 123

TIP  This procedure shows a plug-and-play installation for the Hewlett Packard
HP deskjet 5650 printer.

1. Connect the printer to a USB host port on the terminal.

2. Plugthe power cord of the printer into an outlet and turn on the printer.
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Windows automatically detects your plug-and-play printer, and in most
cases, without requiring you to make any selections.

The printer is ready to print.

IMPORTANT  If automatic plug-and-play installation is not supported for a printer, the
error is logged to the System Event log in the Hardware Monitor.

For example: JETCET PRINT was unable to auto-configure printer. To
configure the printer manually, go to the Printers folder from the Control
Panel.

3. Verify printer installation from the desktop control panel by opening the
Printers ‘¢ application.

Notice the icon for the Deskjet 5650C printer. The check mark
indicates that this printer is the default printer.

4, From the File menu, choose Properties to view the properties of the
P prop
printer.

Deskjet. 5650c Properties W W

General |RDF‘,’ICA I Sharing I

Printer Mame:

Manufacturer: IHewIett-Packard

Model; IDeskjet SE50c
Port: IUSEI Printer (hp deskjet S600-100824836)
[]Hald Jobs

Driver

Driver: |wt5hpapd.d|| (v5.2.1069)

Update Drivers...

Printer properties include the printer name, manufacturer and model,
print driver, and port-specific parameters.

TIP - New printer configurations are retained through a power cycle.

«  Printers that are configured through the desktop control panel are also
available within FactoryTalk View ME Station when pressing Terminal
Settings>Print Setup.

5. To verify the installation, right-click the printer and print a test page.

When printing from an application such as WordPad, a Print dialog box opens
where you can adjust settings.
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Insert an SD Card

Printer: Deskjet S650C Print Range DOrientation
Part; [JETCET PRINT - @ Portrait
e I —— () Selection () Landscape
et Path:
Paper Size:! ILetter v Margini; (inches) |
Left: |1.25" Top: 1
Draft Mode
Advanced Color Right: [1.25" Bottom: 1"

Manual Printer Installation

Follow these steps to install a supported printer manually.

Connect the printer to a USB port of the terminal.

Plug the power cord of the printer into an outlet and turn on the printer.

From the desktop control panel, open Printers
Click Add Local Printer.

File ¥iew Tools Help

|
Add Local Add
Printer RDP/I...

5. Follow the Add Local Printer Wizard instructions to configure the
printer:

a. Verify that the connected printer appears on the USB printer port.
b. Select the manufacture and model of the JETCET printer.

c. Accept the default printer name or enter another.

d. To verify the installed printer, print a test page.

o

Specify whether you want the printer to be shared on the network.

An SD card provides extra storage when inserted into the SD card slot of the
terminal. Supported cards include catalog numbers 1784-SD1 and 1784-SD2.
The SD cards are hot-swappable; they can be inserted and removed while the
terminal is powered on and in operation.

A\

WARNING: EXPLOSION HAZARD

If you remove or insert an SD card while the power is on, an electric arc can
occur. This action can cause an explosion in hazardous location installations.
Do not remove and insert the SD card unless power has been removed or the
area is known to be nonhazardous.

For ATEX and hazardous location installations, the SD card cover must be
installed.
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The SD card slot is accessible from the inside or back of the panel when the
operator terminal is installed.

Follow these steps to install an SD card in the card slot.

1. Remove the protective cover from the card slot.

2. Verify that the SD card is locked or unlocked according to your
preference.
e Ifunlocked, the terminal can write data to or read data from the card.

o Iflocked, the terminal can only read data from the card.

Unlocked

ATTENTION: Orient the SD card correctly before inserting into slot.
If you force the card into the slot, you can damage the card or the

terminal.

3. Insert the SD card firmly into the slot.

[f

(o

To remove the card, grasp the end of the card and pull it out.

4. Attach the protective cover over the card slot (the protective cover is

shipped with the terminal).
==

[ e—
—
—

el Q@
)
g

Rockwell Automation Publication 2711P-UM007G-EN-P - August 2021



Chapter 5

ATTENTION: The cover is required to secure the card in high-shock
A and vibration environments. It also prevents ESD discharge to the

card during runtime operation.

Replace the Battery The product has a lithium battery that provides backup power for the real-time
clock and static RAM. The battery can be replaced while the product is
mounted in the panel. No special tools are required to replace the battery.

X

This product contains a sealed lithium battery, which may need to be replaced
during the life of the product.

At the end of its life, the battery contained in this product should be collected
separately from any unsorted municipal waste.

The collection and recycling of batteries helps protect the environment and
contributes to the conservation of natural resources as valuable materials are
recovered.

A\

WARNING: There is a danger of explosion if the lithium battery or real-
time clock module in this product is incorrectly replaced. Do not replace the
battery or real-time clock module unless power has been removed and the
area is known to be nonhazardous.

Replace the battery only with catalog number 2711P-RY2032 or an equivalent
(R2032 coin-cell battery.

Do not dispose of the lithium battery or real-time clock module in a fire or
incinerator. Dispose of used batteries in accordance with local regulations.

For safety information on the handling of lithium batteries, including handling
and disposal of leaking batteries, see Guidelines for Handling Lithium
Batteries, publication AG 5-4.

Perchlorate material — special handling may apply. See www.dtsc.ca.gov/

hazardouswaste/perchlorate.

This perchlorate warning only applies to primary Lithium Manganese Dioxide

(LiMnO?) cells or batteries, and products containing these cells or batteries,

sold or distributed in California, USA.

Follow these steps to replace the battery.

1. Disconnect power from the terminal.

2. Remove the battery cover by rotating it from the C (closed) to the O
(open) position.
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3. To disengage the battery, on the metal latch, press the vertical center tab
away from the battery.

The battery is released.

4. Insert the new battery at an angle under the metal latch, with the
positive polarity (+) up.

5. Gently press down on the opposite side of the battery until it locks into
place.

IMPORTANT  Make sure that the battery is fully inserted under the plastic tabs. If the
battery is not fully inserted, the terminal can be damaged.

6. Replace the battery and rotate the cover from the O (open) to the C
(closed) position.
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Install a Protective Oveﬂay The overlay protects the terminal touch screen from scratches, dust,

fingerprints, and external damage from chemicals or abrasive materials. See
Table 4 on page 17 for a list of available protective overlays.

The protective overlay covers the entire
surface of the terminal bezel inside the plastic
perimeter. The overlay has a protective liner
that is removed by pulling back on the tab. Do
not remove the liner until you are ready to
install the overlay.

IMPORTANT  Follow these precautions when installing the protective overlay:

Make sure that your hands are clean and dry.

« Handle the overlay by its edges. If you get marks or lint on the overlay,
remove them before proceeding.

+ Do not touch the adhesive ring.

Before installing the overlay, use a lint-free cloth and a mild glass cleaner to
clean the touch screen surface. Remove all fingerprints, grease, or dust. Marks
not removed are trapped underneath the overlay. Grease also affects the
adhesion of the overlay.

To apply the protective overlay, follow these steps.

1. Disconnect power from the terminal.

2. Pull the tab from one of the short sides and partially peel the liner away
from the adhesive layer.

AdhesiveRing —__|

Protective liner
Tab (covers adhesive)
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Hold the peeled back portion of the protective liner out of the way as
you perform the next step.

Overlay

P Bezel

’

Protective Liner

3. Center the overlay over the bezel and carefully position the adhesive
surface on the terminal.

While the protective liner is still covering the rest of the overlay, verify
that it is properly centered.

4. 'To press the overlay on the screen, slowly peel off the rest of the liner
while using a soft cloth.

Make sure that the overlay lies flat with no bubbles or warps.

5. With a soft cloth or finger, press around the edges of the overlay to seal
it, and remove any air bubbles trapped in the adhesive.

Clean the Overlay

To clean the overlay, use a clean, lint-free cloth, and a mild glass cleaner that
leaves no streaks. Windex or an eye glass cleaner is recommended. Do not use
cleaners that contain abrasives.

Remove the Overlay

Remove the overlay if it is damaged or needs replacement. Lift a corner and
slowly pull off the overlay. To remove any residual adhesive, use isopropyl
alcohol. Do not reuse the overlay.
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Terminal Firmware

Update Firmware

Topic Page
Terminal Firmware 129
Download Firmware Files 130
Firmware Upgrade Wizard 131
Upgrade the Terminal Firmware from a Storage Device 131
Upgrade Terminal Firmware over the Network 135

Firmware components are packaged as execute-in-place (XIP) regions in one
system code (SC) .img file. When the SC .img file is copied to the virtual file
system (VES) on the terminal, the XIP regions are updated and the terminal

restarts automatically. These firmware components are affected during an

upgrade:

A firmware update does not affect these terminal components or settings:

FactoryTalk® View ME Station software

Communication protocols and drivers including Kepware drivers
Windows fonts

Windows CE components

FactoryTalk components

User extensions

Windows registry

File system including the FactoryTalk View ME application that is
loaded" in the terminal

Network parameters including the network device name, DHCP-
enabled and static® 1P addresses, speed, and duplex setting
Display settings

Screen saver configuration

Touch screen calibration

(1) Insome cases, the FactoryTalk View ME application can be missing after a firmware update.
(2) Insome cases, static IP addresses have been changed to DHCP-enabled IP address after a firmware update.
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Download Firmware Files Download the appropriate firmware installation package from the Rockwell
Automation Product Compatibility and Download Center. The package is
named:

PVP7_<terminal family>_x.xx-yyyymmdd.exe, where:

<terminal family> is the name of the terminals

x.xx is the FactoryTalk View ME software version that is contained in

the package
yyyymmdd is the date that the package was created

This installation package contains the following items:

Firmware upgrade package (FUP) contains an autorun executable and
the new firmware files.

Firmware upgrade wizard (FUW), version 6.10 or later, is used to
upgrade the terminal firmware by using the contents of the FUP.

The FUP and FUW are copied to your computer during the download.

Follow these steps to download firmware installation files to your computer.

1.

AN

N

From the Quick Links list on http://www.ab.com, choose Product
Compatibility and Download Center.

Click the Get Downloads tab.
Click Find Product Downloads.

From the All Families pull-down menu, choose PanelView* Plus 7.

Select a firmware version, then click Downloads.

Download ~ #8] the upgrade file (.exe) to a temporary folder on the
same drive as FactoryTalk View ME (ME) software.

Run the upgrade file (.exe) installation procedure:
o The FUW is installed in the FactoryTalk View ME folder.
o The firmware upgrade package (.FUP) file is installed into the folder
that is specified during the installation procedure.
TIP  The FUP name is ME_PVP7xA_6=7.xx-yymmdd
yyyymmdd is the date the firmware package was created
7.xx is the version of ME contained in this package

You are now ready to run the FUW to upgrade the terminal firmware from a
USB drive or SD card, or by using a network connection.
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Firmware Upgrade Wizard

Upgrade the Terminal
Firmware from a Storage
Device

The firmware upgrade wizard (FUW) is used to upgrade the terminal
firmware. Two methods are provided for upgrading the firmware:

e Create a firmware upgrade card with the contents of the FUP file that
you can then load in the terminal to upgrade the firmware.
The firmware upgrade card can be a USB drive or an SD card, catalog
number 1784-SDx.

o Upgrade firmware in a terminal that is connected to a computer over a
direct network connection. The network connection requires a
computer running RSLinx® Enterprise software, version 5.0 or later. In
the RSLinx Enterprise software, you select the terminal that you want to

upgrade.

You can run the FUW from within FactoryTalk View Studio software or from
the Programs menu on your computer:

e In FactoryTalk View Studio software, from the Tools menu, choose
Firmware Upgrade Wizard.

e Choose Start>Programs>Rockwell Software>FactoryTalk
View>Tools>ME Firmware Up grade Wizard.

To upgrade firmware from a storage device, you follow a two-step process.
First, you create a firmware upgrade card with the required firmware files.
Second, you load the card in the target terminal to upgrade the firmware.

The firmware upgrade card can be a USB drive or an SD card.

Create a Firmware Upgrade Card

Follow these steps to copy firmware files to a USB drive or SD card.

1. Inserteithera USB drive or an SD card into the appropriate slot on your
computer.
2. Run the Firmware Upgrade Wizard:

e In FactoryTalk View Studio software, from the Tools menu, choose

Firmware Upgrade Wizard.
e Choose Start>Programs>Rockwell Software>FactoryTalk
View>Tools>ME Firmware Upgrade Wizard.
3. Follow these steps from the initial Firmware Upgrade Wizard dialog
box.

a. Click Create firmware upgrade card.
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Firmware Upgrade Wizard ] o

Select the type of fimware upgrade to perform:
" Upagrade fimware on terminal
%' Create fimware upgrade card

Firrnware: card location:

HA _|

Existing terminal type:

Mote: Paneffiew Plus CE FUP should be
used for Yersavfiew CE terminals.

< Back I Mext » I Cancel | Help |

b. Select the location of the firmware card by browsing to the root
directory of the storage card that is loaded in your computer for
example E:\.

The firmware files are copied to this location. You can also specify a

folder on the hard disk.

c. From the Existing terminal type pull-down menu, select a PanelView
Plus 7 terminal.

d. Click Next.

4. Follow these steps from this dialog box.

a. Browse to the location of the firmware source files on your computer,
where the FUP was installed.

€ Firmware Upgrade Wizard =10 x]

Terminal type: Panelfiew Plus 7 [ME «7.00 - +7.10)

Firmnware: source folder:
C:\Program Files'Rockwell SoftwarehRSView Enterprise FUPsh |

Upgrade firmware version:

[ kajor . Minor . Release Date |

< Back I Mext » I Cancel Help

b. Choose the firmware version for the upgrade.

c. Click Next.

It can take several seconds for the next dialog box to appear while the
FUP is being retrieved.

5. From this dialog box, optionally select the KEPServer drivers that you

want included with the firmware, then click Next.
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@ rrmmore upgrade wizard =

Select the KEPServer drivers to be included in the firmware:

O allen-Bradiey Bulletin 1609 a
[ allen-Bradley Bulletin 900

D AutomationDirect DireckMet

O automationDirect EBC

O automationDirect ECOM

Oeacnete

[ <k Ethernet

[ &E Ethernet Global Data

O mitsubishi Ethernet

O titsubishi Fx

O titsubishi Fi2 Met

O ritsubishi Serial x|

< Back I Mext » I Cancel | Help |

Kepware drivers are already installed on the PanelView Plus 7 Standard
terminals.

The final dialog box summarizes your choices for creating the firmware

upgrade card.
€ Firmware Upgrade Wizard ) =] ]

Prezz Finizh to create the firmware upgrade card.

Upgrade type: Firmware upgrade card

Terminal type: Panehfiew Plus 7 ; . [ME «7.00 - +7.10)
Upgrade firmware versiorn: F.00-20141214 [ Major . Minor . Release Date |
Firmnware: card location: H:4

WigwPaint: es

KEPServer drivers: <Mone:

< Back I Finizh I Cancel | Help |

6. Click Finish to copy the firmware files to the firmware upgrade card.

A progress bar automatically updates as files are copied to the USB drive
or SD card.

7. Click OK when the firmware upgrade completes successfully.
x|

-
\}1) The firmware upgrade card was created successfully,

TIP  If the firmware files were copied to the hard disk, copy the files to the
root directory of the USB drive or SD card.

8. Remove the USB drive or SD card from your computer.

9. To use this firmware upgrade card to upgrade the terminal firmware, go
to the next section.
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Upgrade Terminal Firmware by Using a Firmware Upgrade Card

Follow these steps to transfer firmware files from the USB drive or SD card to
the terminal. Use the firmware upgrade drive or card that you created in the
previous section.

IMPORTANT - Do notremove or disconnect the USB drive or SD card while a firmware

upgrade is in process. If you do, you can corrupt the firmware and make

the terminal unstable.

« Do not power off the terminal during a firmware upgrade.
« USB hubs can produce unexpected behavior and are not recommended.

Firmware Upgrade Card o

Firrnware version (Major. Minor. Patch. Build)

Terminal 07.00.00 07.00.00
Upgrade Card 071000

The terminal is about to be upgraded with new firmmware.
FactoryTalk View ME Station and any running applications will
be terminated.

After updating files, the terminal will be restarted fo complate
the upgrade

Press the Upgrade button to continue. Otherwise, press the
Exit button and remave the firmware upgrade card

Upgrade Exit
[F7] [F&]

Insert the USB drive or SD card into the appropriate slot on your
terminal.

The firmware upgrade automatically starts and displays this dialog box.

x|

new firmware.

2. Press Upgrade or [F7] on the terminal to start the firmware upgrade.
The terminal restarts and displays a progress bar during the upgrade.

When the upgrade is complete, the terminal restarts and executes the

3. Remove the USB drive or SD card from the terminal.

IMPORTANT

If the firmware upgrade fails because of a power loss or the firmware

upgrade card is inadvertently removed, you can restore the terminal to the
factory default firmware. See Maintenance Mode Operations on page 145

for details on how to restore the factory default settings.
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Upgrade Terminal Firmware  Youcan upgrade firmware in a terminal that is connected to a computer over a

over the Network

direct network connection. The network connection requires a computer that
is running the firmware upgrade wizard (FUW) and RSLinx Enterprise
software, version 5.0 or later.

RSLinx Enterprise software is required so that you can select the terminal on
the network.

Follow these steps to copy firmware files to the terminal over a network by
using RSLinx Enterprise software and Ethernet communication.

1. Run the Firmware Upgrade Wizard:
e In FactoryTalk View Studio software, from the Tools menu, choose
Firmware Upgrade Wizard.

e Choose Start>Programs>Rockwell Software>FactoryTalk
View>Tools>ME Firmware Upgrade Wizard.

€2 Firmware Upgrade Wizard

Select the type of fimware upgrade to perform:
+ |pgrade firmware on terminal

" Create firmware upgrade card

Cancel Help

2. Click ‘Upgrade firmware on terminal” and click Next.

3. To continue, click Yes.

Firmware Upgrade

<@ Al .MER Files should be backed up and remawed From the Panelview Plus, PanelView Plus CE, or Panelview Plus Compact terminal before performing a
\{/ Firmveare upgrade,

Do you wish to continue?

3 i

It is not necessary to back up files on PanelView Plus 7 Standard
terminals.
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4. Click ‘Network connection (using RSLinx Enterprise)’ and click Next.

€2 Firmware Upgrade Wizard

Select the type of connection to the terminal:

(+ Metwaork connection [using RSLinx Enterprise}
[Only connection type available for uge with FactorT alk Yiew ME Station +6.00 or later terminals.]

" Ethemet connection [using Panel/iew File Transfer Utility]

N

™ Serial connection
[using Paneliew File Transfer Utility and BAS connection]

< Back | Mest » | Cancel | Help |

This option is the only valid selection for PanelView Plus 7 Standard
terminals.

5. To receive the firmware update, select the terminal and click Next.

€ Firmware Upgrade Wizard i =10 %]

Select the terminal:

oSl 10,109, 18,2, 2090-LCS0-240QE, Microgsa 2 d
|- 10.108.18.13, Panelview Plus_6 700, Panelview Plus_6 700

o4l 10.108.18.62, 2080-LCS0-240VE, Micra2S0 9

o4 10.108.18.109, 2080-LCS0-240%B, MicroBs0 5

q-f] 10.108.18.149, 1756-ENBT/A, 1756-ENBT/4 7
]--ﬂ 10.108.18.150, 1756-ENBT /A, 1756-ENBT/A 6
3 1§10, lus_7 600, Pane
|
)
H
)
H

-f] 10.108.18.252, 1756-EMBT/A, 1756-ENBT /4

-] 10.108.18.253, 1756-ENBT/A, 1756-EMBT/4 3

S 10.108.19.1, 2080-LCS0-480QBB, Micross0 8 |-
S 10,108.19.54, 2080-LCS0-4808E, MicroS50 3

-f] 10.108.19.87, 1756-EMBT /4, 1756-ENBT /& 4

F-® 10,105.19.101, Panelview Plus_6 Compact 600, Panelview Flus_6 600 ﬂ

a0 O O O e O e O e O e O O o O e B

Maode: Onling Mot Browsing

< Back I Mest » I Cancel Help
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6. Follow these steps from this dialog box.

Firmware Upgrade Wizard oy =] B3

Selected terminal

Terminal type: Panelview Plus 7 600 [ME 700 - %710

Firmware wergion: FAM].00.1100.11 [ Major . Minar . Patch . Build )
Firmware source folder:
C:\Program Files\Rockwell Software R SView EnterprisetFLIPsY |
Upgrade firmware version:

[ Major . Minor . Release Date |
< Back I Mext > I Canicel | Help |

a. Browse to the location of the firmware source files on your computer,

where the FUP was installed.

The default location is shown.

b. Choose the version of the upgrade firmware from the pull-down

menu.

c. Click Next.

It can take several seconds for the next dialog box to appear while the

FUP is being retrieved.

7. From this dialog box, optionally select the KEPServer drivers that you

want included in the firmware, then click Next.

0 Firmware Upgrade Wizard
pg!

Select the KEPServer drivers to be included in the firmware:

[ allen-Eradley Bulletin 1609 ~
[ allen-Bradley Bulletin 200

D AutomationDireck Direckhet

[ automationDirect EBC

[ automationDirect ECOM

Oeacretie

[ GE Ethernet

[ cE Ethernet Global Daka

O Mitsubishi Ethernet

O Mitsubishi Fx

O mitsubishi F rek

O mitsubishi Serial w

< Back | Mesxt > |

EoX

Cancel ‘ Help |

Kepware drivers are already installed on the PanelView Plus 7 Standard

terminals.
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The final dialog box summarizes your choices for upgrading the terminal

firmware.
€ Firmware Upgrade Wizard 1 =[O x|
Press Finish to upgrade the firmware on the terminal.
Upgrade type: Terminal fimware upgrade
Teminal type: Paneliew Plus  BOO0[ME +7.00 - ¥7.10)
Current firmware version: 7.00.00.09.17.09 [ Major . Minor . Patch . Build ]

Upgrade firmware version: 70-20141217
YiewPoint: Ho

KEPServer drivers: <Mone>

< Back I Finish I Cancel | Help

8. Click Finish to update the firmware in the terminal.

9. To continue with the update, click Yes.

Firmware Upgrade

::/ The terminal is about to be upgraded with new firmware,
. )

FactoryTalk View ME Station and any running applications will be terminated.
After downloading files, the terminal will be restarted to complete the upgrade,

Do you wish to continue?

A progress bar updates as firmware files are copied to the terminal.

10. Click OK when the firmware upgrade is complete.

Firmware Upgrade Wizard

The upgrade files have been downloaded ko the terminal.

Check the terminal for any specific actions necessary to complete the reboak,

The terminal restarts and executes the new firmware.

IMPORTANT  [f the firmware upgrade fails because of a power loss or the firmware
upgrade card is inadvertently removed, you can restore the terminal to the
factory default firmware. See Maintenance Mode Operations on page 145
for details on how to restore the factory default settings.
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Troubleshooting

Topic Page
View System Information 139
Status Indicators 140
Terminal Does Not Start Up 140
Terminal Restarts Intermittently 141
Touch Screen Issues 14
Display Issues 142
Ethernet Issues 143
Performance s Slow 143
Resistance to Chemicals 143
Clean the Display 144
Ship the Terminal 145
Maintenance Mode Operations 145
View System Information View system information for the terminal from FactoryTalk® View ME Station

runtime or from the Hardware Monitor in the control panel.

Follow these steps to view system information for the installed components.

1. Access FactoryTalk View ME Station runtime.

2. Tap Terminal Settings, then choose System Information>About
FactoryTalk View ME Station.
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Status Indicators

Terminal Does Not Start Up

140

The back of the terminal has two indicators to identify system status:

e Terminal or STS indicator (green) indicates that the terminal is on and
running

o Fault or ERR indicator (red) indicates hardware and firmware faults

Fault Terminal
(orERR)  (orSTS)

At startup, the Terminal (or STS) and Fault (or ERR) indicators flash on and
off, then the Terminal (or STS) indicator flashes to signal progress during

startup. If the indicators remain off, check the power cable.
After a successful startup, the Terminal (or STS) indicator remains on.

The table shows indicator states if the terminal stops during startup.

Table 32 - Fault Indicator States During Terminal Startup

Faultor | Terminalor

ERR (red) | STS (green) Description Recommended Action
Recoverable firmware error. Reload the firmware.
Blinking Off Recoverable configuration failure. Restore the terminal to its factory

defaultimage. Refer to Restore a Back-
up Image on page 88.

On Fatal hardware error. Replace the terminal.
On

Blinking Fatal display hardware error. Replace the terminal.

If the terminal does not start up normally, check the table for possible causes.

Table 33 - Terminal Does Not Start Up Properly

Check For What to Do See This Page
Insufficient power Make sure that the device is receiving adequate power.

« (Check the DC power requirements. page 36
Improper power wiring | Verify that the power wiring is correct.

« Check the wiring specifications. page 35

+ Check the DC power wiring. page 36
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Terminal Restarts
Intermittently

Touch Screen Issues

Table 33 - Terminal Does Not Start Up Properly

Check For What to Do See This Page
Status indicators Check the status indicators during startup. page 140
Stalled progress If a terminal stalls at the progress indicator and does not load an page 88
indicator application or configuration screens, reload the firmware or restore

factory defaults.
Object that is touching | Verify that nothing is pressing against the display or that you are not | N/A
the display touching the display during startup.

If the terminal restarts intermittently, check the table for possible causes.

Table 34 - Terminal Restarts Intermittently

Check For What to Do See This Page
Improper power Verify that the power wiring is correct.
wiring « (Check the wiring specifications. page 35
« Check the DC power wiring. page 36
Over-temperature | Make sure that the processor is not exceeding temperatures for
conditions normal terminal operations.
« (heck the processor temperature. page93
« Check the System Event log for over-temperature conditions. page 71 or page 92
« Check for adequate clearances around the terminal in the panel. | page 24
« Check for proper operating temperature. page 93

If the touch screen is not responding correctly to touches with a finger or
stylus, check the table.

Table 35 - Touch Screen Not Responding

Check For What to Do See This Page

Improper calibration | Check for activation points that are offset from touch points. page 65 or
Calibrate the touch screen. page 115

Non-functioning Check the touch screen for damage, such as cuts or excessive wear. | N/A

touch screen If there is damage, replace the terminal.

Touching multiple Application screens contain graphic input elements that are N/A

input elements

configured in the Machine Edition application. When touched,
these elements perform operations in a predictable manner. For
example, an input element is configured to navigate to a specific
screen in the application or start a motor when touched.

Multiple operations cannot be conducted simultaneously. Doing so
results in an unintended operation.

+ Do not touch multiple input element simultaneously.

« Do not rest a hand or multiple finger on the display.
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Display Issues

142

The display is unreadable or dims unexpectedly.

A\

ATTENTION: If the display darkens, or if the backlight is not functioning
properly, the screen can be difficult to read and use of this touch screen
could result in a potentially hazardous outcome. Do not use the touch
screen under these circumstances. The design of the system must take
into account the possibility of the touch screen losing functionality and
unable to be used to maintain or change control of the system. The touch
screen shall not be the single point of control of critical functions and is not
intended to replace an E-stop.

Design of the system should follow all applicable code and good engineering
practice. Factors to consider include:

« The possibility of an unreadable touch screen

«  The possibility of an inoperable touch screen

« Unexpected communication errors or delays

« Operator error in the control of the system

« Proper use of E-stops and other safety practices

The user shall provide means to achieve a safe state during anomalies and
make sure the system has adequate redundancy for critical functions.

Failure to follow these instructions can result in death, serious injury,
or equipment damage.

Table 36 - Dim Display

Check For See These Pages

Low display brightness setting page 63 or page 90
Low brightness level of screen saver page 64 or page 91
Temperatures outside the operating range page 72 or page 93

TIP  Extend the life of the backlight by reducing the display brightness, by using

the screen saver with reduced brightness, or operating at lower
temperatures.
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Ethernet Issues See Figure 37 on page 143 for tips on how to isolate Ethernet anomalies.

Table 37 - Ethernet Connection Issues

Check for These Issues What to Do

Status of invalid Ethernet connection - Green indicator is on when a link is established.
« Yellow indicator blinks when activity is detected.
« Verify network connections.

Poor cable connections Check the Ethernet cabling for the following:
+ Make sure that cables are fully connected.
+ Check for cable crimping.

+  (Check the Ethernet switch connections.

+ Check the Uplink ports.

Invalid IP address of terminal Go to Set the Ethernet Address of the Terminal on page 57.

If DHCP is enabled, the terminal automatically acquires a valid IP
address from the network after startup. The TCP/IP protocol
automatically assigns 169.254.xx.xxx when it fails to acquire an
IP address from the network. In general, an IP address that begins
with 169 does not support a network connection.

Conflicting IP addresses If DHCP is not enabled and a static IP address is specified, make
sure that the IP address does not conflict with the address of
another device on the network.

Performance Is Slow If the response time of the application is slow, for example screen changes or
text display changes, check for the following issues:

o Application screens contain too many elements.
e Ifthe controller is programmed for feedback, it can cause delays.

e Slow network performance or noise can result in retries.

Resistance to Chemicals The outer surfaces of the terminal including the bezel, touch screen overlay,
and panel sealing gasket are tested for chemical resistance. Some of the
chemicals can cause discoloration, but they do not interfere with the operation
of the terminal.

TIP  For more information on chemical resistance of the product, go to

http://www.rockwellautomation.com/knowledgebase and search the
Knowledgebase for keywords ‘Chemical Resistance PanelView™ Plus.

IMPORTANT Do not operate the terminal in direct sunlight. Direct exposure to
ultraviolet light can discolor the touch screen.
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Clean the D|Sp|ay A protective overlay can help extend the life of the terminal and make it easier

to clean the display. Table 4 on page 17 provides catalog numbers for overlays.

A\

ATTENTION: Do not use abrasive cleaners or solvents, they can damage the
display. Do not scrub or use brushes.

Do not apply cleaning solution directly on the screen of the terminal. The
solution can drip or seep onto the gasket. Apply cleaning solution to a clean
sponge or soft cloth, and gently wipe the screen to remove the dirt and grime.

To clean the display, follow these steps.

1. Disconnect power from the terminal at the power source.

2. To clean the display and to prevent scratches, use a clean sponge or soft
cloth with mild soap or detergent.

3. Dry the display with a chamois or moist cellulose sponge to avoid water

spots.

Remove Paint and Grease

Follow these steps to remove paint or grease from the bezel that is properly
mounted in a NEMA, UL Type, or IP rated enclosure.

1. Rub lightly with isopropyl alcohol (70% concentration).

2. To remove residue, use a mild soap or detergent solution.

3. Rinse with clean water.

Equipment Wash Downs

A\

ATTENTION: Do not use a high-pressure washer for cleaning the front bezel
of the terminal. A high-pressure washer can damage the terminal.

Do not use a high-pressure washer for cleaning vented enclosures. Water can
enter the enclosure and damage the terminal and other equipment.

Itis possible for screen objects to activate during equipment wash-downs if the
terminal is turned on.
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Sh|p the Terminal If you ship the enclosure with the terminal installed, make sure that the

terminal is properly secured and protected against damage from impact, sharp
objects, or abrasive materials.

ATTENTION: Rockwell Automation is not responsible for damage to a
product that is shipped or transported while installed in a panel or
enclosure.

Maintenance Mode To start the system in Maintenance Mode for diagnostics and repairs, press and

Operations

hold the white box that shows in the lower left corner of the display during
startup.

TIP  To access the Maintenance Mode menu, you can also attach a USB
keyboard and hold down the F1 key.

If an ME application is set to run at terminal startup, press and hold the white
box during startup to put the terminal into Safe Mode.

Table 38 - Maintenance Mode Operations

Operation Description

None Exits Maintenance mode and continues with a normal restart.

Starts the system in Safe Operating mode. Safe mode is a diagnostic mode with reduced functionality that lets you recovery from a software

Safe mode anomaly. In Safe mode, you can repair corrupted applications or changes that caused the anomaly.

Important: FactoryTalk View ME Station software does not run the HMI.mer application on startup if one is loaded, but instead enters Configuration
mode. The HMI application runs the next time that the system is reset.

Clear all data Restores all user-accessible storage and configuration data on the terminal to its default state. The current firmware revision is retained.
Important: All storage media is returned to its original state when purchased except for the firmware. The latest FactoryTalk View ME image is
retained. All user data changes or additions are lost.

Factory default Restores all storage media on the terminal to its initial factory default state, including firmware, registry, file system, and configuration data.

Typically, this option is used to recover from a failed firmware update.
Important: All storage media is returned to its original state when purchased. All user-installed, firmware updates are removed.
Refer to Restore a Back-up Image on page 88 for details on how to perform a restore.

Perform maintenance operation in this order to diagnose and repair problems:
e Safe mode — stops an application from starting automatically.

¢ Clear all data — removes user-installed applications, user-configuration
changes, and user accessible data.

o Factory default — returns the terminal to its out-of-box state.
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Notes:
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TrueType Fonts

Fonts Resident on Terminal

The table lists TrueType fonts that are pre-installed on the terminals. The

default system font is Tahoma.

TIP  The Arial Unicode MS font contains almost 50,000 characters. The font
provides default language support for many non-Latin languages and
scripts including Arabic, Hebrew, Vietnamese, Thai, Hindi (Devanagari),
and other Indic languages. The font also includes Chinese, Japanese, and

Korean (CJK) support.

You can load more fonts on the system by copying the font files to the
\Windows\Fonts folder on the terminal desktop. To access this folder, open

the My Device icon on the terminal desktop or choose

Start>Programs>Windows Explorer.

IMPORTANT  OpenType fonts (.otf) can contain many extra symbols and characters and
can have large files sizes. If you install OpenType fonts, it can resultin a
reduction in available memory for applications. We recommend that you
install only TryeType fonts. If you need an OpenType font, install only the

font family that you want to use.

Table 39 - TrueType Fonts (.ttf and .ttc)

Font Type Font Name File Name
Arial Unicode MS version 1.01 arialuni.ttf
Arial
Arial (Subset 1_30) arial_1_30.ttf
Arial Black arialk.ttf
Arial Bold arialbd.ttf
Arial Bold Italic arialbi.ttf
Arial ltalic ariali.ttf
Latin Fonts Comic Sans MS
Comic Sans MS comic.ttf
Comic Sans MS Bold comichd.ttf
Courier New
Courier New (Subset 1_30) cour_1_30.ttf
Courier New Bold courbd.ttf
Courier New Bold Italic courbi.ttf
Courier New Italic couri.ttf
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Table 39 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
Georgia
Georgia georgia.ttf
Georgia Bold georgiab.ttf
Georgia Bold Italic georgiaz.ttf
Georgia Italic georgiai.ttf
Impact impact.ttf
Kino kino.ttf
Microsoft Logo mslogo.ttf
Symbol symbol.ttf
Tahoma
Tahoma (Subset 1_07) tahoma_1_07.ttf
Tahoma Bold tahomabd.ttf
Times New Roman
Latin Fonts Times New Roman (Subset 1_30) times_1_30.ttf
Times New Roman Bold timeshd.ttf
Times New Roman Bold Italic timesbi.ttf
Times New Roman Italic timesi.ttf
Trebuchet MS
Trebuchet MS trebuc.ttf
Trebuchet MS Bold trebuchd.ttf
Trebuchet MS Bold Italic trebucbi.ttf
Trebuchet MS Italic trebucit.ttf
Verdana
Verdana verdana.ttf
Verdana Bold verdanab.ttf
Verdana Bold Italic verdanaz.ttf

Verdana Italic

verdanai.ttf

Webdings

webdings.ttf

Symbols

Wingding

wingding.ttf
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Table 39 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
PV12x24,PV12x8 PV12x24.ff, PV12x8.ttf
PV16x24 PV16x24.ttf
PV18x16,PV18x8 PV18x16.ttf, PV18x8.ttf
PV24x32 PV24x32.ttf
PV32x40, PV 32x 64 PV32x40.ttf, PV32x64.ttf
PV4x6 PV4x6.ttf
PV6x16,PV6x24,PV6x8,PV6xX9 PV6x16.ttf, PV6X24.tf,
PV6x8.ttf, PV6X9.ttf
PanelView Fonts PV8x16,PV8x20,PV8x24 PV8x16.ttf, PV8x20.ttf,
PV8x24.1tf
PV Double High PVdouble_high.ttf
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Appendix A

Notes:
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Symbols
.mer application 43, 47, 55, 61, 70

A

access configuration mode
from an HMI application 43
from the Windows desktop 43
Goto configuration mode button 43
accessories 17
ActiveX controls 14, 74
alarms 71
application
back up 86
checking integrity 70
restore 86
ATEX
installations 13
atmospheric gases ignition temperature 23
authenticating client connections 96

B

back-up image 88
back-up power 125
battery

back-up power 125

conditions 93

lithium 125

replacement 125

view voltage 93

warnings 112
battery voltage 72
boot options 113
branch circuit 20
button styles 113

C

cable

lengths between Ethernet ports 38
calibration

touch screen 65, 115
catalog numbers
battery replacement 18
mounting hardware 17
PanelView Plus 7 standard terminals 16
power supplies 17
power terminal blocks 17
protective overlays 17
SD cards 17
USB programming cable 17
circuit breaker rating 20
clear all data 145

closed system 113

command prompt

Foxitreader 117

parameters 117

syntax 117
configuration mode 15
configure start-up options 43
control panel

touch screen calibration 115
cutout dimensions 25

D

date

setting 76
date format
long 79
short 79
DC power bus 36
desktop
appearance 90
background image 90
brightness 90
cursor 91
rotate 91
screen saver 91
desktop access
default password 48
disable 49
enable 48
password 48
reset password 52
restrict 48, 49
set password 51
device name
terminal 60
DHCP 57
diagnostics 69
advanced 114
dimensions
panel cutout 25
display
adjust backlight 63

E

earth ground

connection 37

wire 36
electrostatic discharge 119
environment and enclosure notice 20
ESD

preventing 119
Ethernet

connector pinout 38

driver 56

duplex setting 58

link speed 58

status indicators 38
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152

event log
errors 71
events 71
warnings 71
explosion hazard 35, 38, 125

F

FactoryTalk View ME
check file integrity 70
diagnostics 70

Fault indicator 140

fault indicators

firmware 140
hardware 140
file server

configuration 110
firmware

copy upgrade files
to a USB flash drive 131
toan SD card 131
corrupted 134
downloading 130
revision 74
upgrade fails 134, 138
upgrade methods 131
upgrade package 130
upgrade wizard 131
firmware upgrade
using storage device 131
via network connection 135
via SD card 134
via USB flash drive 134
wizard 131
fonts 147

Foxitreader 117
FTP security options 108
FTP server

configuration 107
parameters 107
ftp server
security 107
FUP 130
fuse rating 20
FUW 130

G

galvanicisolation 120

hardware specifications

battery 13
display/touch screen 12
Ethernet port 12
SD card slot 13
status indicators 13
USB device port 12
USB host port 12

HMI 7

indicator

Fault 140
Terminal 140
INMETRO

installations 13
input panels 84
installation

panel cutouts 25
IP address

assign 57

K

KEPServer drivers 132, 137
keyboard 84

L

ladder logic 7
language

setting 77
lithium batteries

safe handling 125
log files

application files 70

delete 62

runtime files 70

M

maintenance mode 145
ME7
mount the terminal
ambient temperature 24
clearances 24
ina panel 30
location considerations 24
minimum clearances 24
mounting levers 26
preparation 26

network
file servers 110
FTP servers 107
topology 37
types supported 37
VNCservers 99
network topology
device level ring (DLR) 38
linear 39
star 40
numeric keypad 13

P

panel cutout dimensions 25
PDF reader 116
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Index

power
24V DCnominal 36
connection 36
DCbus 36
ratings 36
specification 12
supplies 36
terminal block
install 35
remove 35
wire specifications 35
power supply
PELV 36
SELV 36
print setup 67

printers 121
processes

memory usage 92
running on the terminal 92

product compatibility and download center

8
protective overlay 127
cleaning 128

installing 127
removing 128

release notes 8

reset terminal 43

restore application 86

RJ45 connector 38

RSLinx Enterprise software 56

S

safe mode 113, 145

safety notices
battery replacement 125
earth ground connection 37
electrical arc 35, 38, 123
electrical shock 119
emergency stops 19
explosion hazard 35, 38
grounding USB devices 120
wiring and safety guidelines 20

screen cursor
enable/disable 64

screen saver

configure 64
SD card
ATEX 13
INMETRO 13
installing 124
slot 124
server
addresses 59
enable/disable 98
file 110
ftp 107
set up printers 67

shell options 112
soft keyboard controls 46
software versions

FactoryTalk View Machine Edition Station 14
FactoryTalk View Studio for Machine Edition

14

FactoryTalk ViewPoint 14
startup

configure 43

options 15, 41, 53

sequence 41
status indicators 140

Ethernet 38
system

information 139

status 140
system event log 92

maximum size 92

T

technical support 74
temperature

code T4 23

conditions 93

failed sensor 93

view current temperature 93
terminal

device name 60

settings 45
terminal block

power 35
terminal configuration

closed system 14

open system 14
Terminal indicator 140
terminal status

battery voltage 72
memory allocation 73
runtime RAM 73
time
format 78
setting 76
zone 75
touch screen
calibrate 65, 115
gestures
double-tap 13
drag 13
long press 13
tap 13
input 13
set sensitivity 66
touch screen calibration 115

troubleshooting 92
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U

UsB

cables 121
device port 120
host port 120
hubs 121
printer 121
USB to serial port adapters 18

user accounts 96

)

virtual keyboard 13
VNC 14

configure 99

connection passwords 99
control passwords 100
server parameters 99
view-only password 100

w

watchdog errors 114
Web server parameters 106
Windows CE

operating system 14
features 81
server support 83
Windows control panel 85

Windows Explorer 84
wiring and safety guidelines 20
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Rockwell Automation Support

Use these resources to access support information.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. |rok.auto/support
Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport
Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature
Product Compatibility and Download Center Download firmware, associated files (such as AOP, EDS, and DTM), and access product

(PcDe) release notes. rok.auto/pede

Documentation Feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our
content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.

Allen-Bradley, ArmorBlock, CompactLogix, ControlLogix, expanding human possibility, FactoryTalk, FLEX, Kinetix, PanelView, POINT I/0, RSLinx, PowerFlex, Stratix 6000,
Studio 5000 Logix Designer, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.

EtherNet/IP is a trademark of ODVA, Inc.
SD and SDHC are trademarks of SD-3C LLC.
Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.S. Kar Plaza is Merkezi E Blok Kat:6 34752, igerenk{y, istanbul, Tel: +90 (216) 5698400 EEE Y0netmeligine Uygundur

Connect with us. nm y

rockwellautomation.com expanding human possibility*

AMERICAS: Rockwell Automation, 1201 South Second Street, Milwaukee, WI 53204-2496 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382.4444
EUROPE/MIDDLE EAST/AFRICA: Rockwell Automation NV, Pegasus Park, De Kleetlaan 12a, 1831 Diegem, Belgium, Tel: (32) 2 663 0600, Fax: (32) 2 663 0640
ASIA PACIFIC: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846
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